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Welcome to NetWare 5.1

NetWare® 5.1 is the number one server platform for your network and your 
Internet-enabled business.

NetWare 5.1  turns a server-class PC into a high-performance network server, 
providing connectivity among personal computers, printers, mass storage 
devices, and the Internet.

NetaWare 5.1 gives you superior management and control of your entire 
network and Internet servers, by offering the following key advantages:

� A fast, reliable, and manageable networking platform for both network 
and Internet-enabled applications, including one of the fastest and most 
reliable Java* Virtual Machines (JVMs) for running Java applications.

� Support for Hypertext Transfer Protocol (HTTP), the protocol that Web 
servers and Web browsers use to communicate on the Internet—and  now 
on the local network too.

� Full-service Directory capabilities of NDS® 8 and native support for 
LDAP v3, the protocol that allows customers to access Directory 
information from many different locations.

� NDS management tools that help you set up, configure, and manage your 
network and Internet resources.

Whether your network has a single NetWare 5.1 server or hundreds of 
NetWare, NT, and UNIX* servers located on local sites, at sites around the 
world, or on the Internet, NetWare 5.1 is what you need.

���	
�For descriptions of some of the key products and services that are included 
with NetWare 5.1, see “Install Networking Products” on page 103.
Welcome to NetWare 5.1 �
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Installation and Upgrade Options

Several options are available for installing or upgrading to NetWare 5.1. If you 
have specific tasks in mind as you begin to use NetWare 5.1, refer to the 
following chart for references to relevant documentation.

���	
�NetWare 5.1 online documentation and any relevant corrections or updates 
are also available at the Novell Product Documentation Web site (http://
www.novell.com/documentation).

If you want to Refer to

Add a NetWare 5.1 server to an 
existing network

Chapter 1, “Install a NetWare 5.1 
Server,” on page 13

Upgrade an existing NetWare 3, 
NetWare 4, or NetWare 5 server

Chapter 2, “Upgrade a NetWare Server 
to NetWare 5.1,” on page 57

Transfer data from an existing 
NetWare server to a new 
NetWare 5.1 server

Chapter 3, “Using Novell Upgrade 
Wizard,” on page 63

Install or upgrade workstations to 
the latest Novell® ClientTM 
software

Chapter 4, “Install Novell Clients,” on 
page 89

Install additional networking 
products and services

Chapter 5, “Install Networking Products,” 
on page 103

Upgrade using other installation 
options

NetWare 5.1 Online Documentation CD
�
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User Comments

We want to hear your comments and suggestions about this manual and the 
other documentation included with NetWare 5.1.

To contact us, send e-mail to webdoc@novell.com, or send comments to:

Novell, Inc.
Product Documentation
MS PRV-C-231
122 East 1700 South
Provo, UT 84606-6194 USA
Fax (801) 861-3002
Welcome to NetWare 5.1 ��
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� Install a NetWare 5.1 Server

This chapter describes how to install a NetWare® 5.1 server. The installation 
process includes the following tasks:

� Meet system and software requirements

� Prepare the network and the computer

� Specify hardware and software settings

� Create a NetWare partition and volume SYS

� Name the server and install the server file system

� Install networking protocols

� Set up NDS®, the Novell® directory technology

� Install other networking products
Install a NetWare 5.1 Server ��
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Meet System and Software Requirements

System Requirements

NetWare 5.1 has the following minimum system requirements:

� A server-class PC with a Pentium* II or higher processor.

� A VGA or higher resolution display adapter (SVGA recommended).

� A DOS partition of at least 50 MB with 35 MB available space.

� Minimum disk space requirement outside the DOS partition:

� Standard NetWare products plus WebSphere* Application Server for 
NetWare—1.3 GB for volume SYS.

� Minimum memory requirements:

� Standard NetWare products—128 MB.

� NetWare products plus WebSphere Application Server for 
NetWare—256 MB (512 MB recommended).

� All products including Oracle8—512 MB.

� One or more network boards.

� A CD drive. Bootable CD drives must support the El Torito specification.

� A PS/2* or serial mouse is recommended, but not required.

���	
�The system requirements listed above are minimum requirements. You can 
optimize the server performance by increasing the amount of server memory, disk 
space, and processor speed.
�� Installation Guide
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Software and Other Requirements

Before installing, make sure that you have the following software and 
information:

� If this is the first NetWare 5.1 server on the network, you must:

� Make sure that this server will be a reliable, accessible, and 
continuing part of your network.

���	
�The first NetWare 5.1 server will automatically create and physically 
store the Organizational Certificate Authority (CA) object for the entire NDS 
tree. The Organizational CA object enables secure data transmissions and is 
required for Web-related products such as NetWare Web Manager and 
NetWare Enterprise Web Server.

���������
�Once the Organizational CA object is created, you should not 
delete or move it.

� Have Supervisor rights at the [Root] of the NDS tree.

� If this is not the first NetWare 5.1 server on the network, you must:

� Have Supervisor rights to the container where the server will be 
installed.

� Have Read rights to the Security container object for the NDS tree.

� NetWare 5.1 Operating System CD.

� NetWare 5.1 License/Cryptography diskette.

� DOS 3.3 or later. (DOS 7 is included on the NetWare 5.1 License/
Cryptography diskette.)

���	
�Do not use the version of DOS that ships with Windows* 95, Windows 98, 
or Windows NT* operating systems.

� DOS CD drivers.

� Client connection utilities (optional, for installing from a network):

� Novell ClientTM for DOS and Windows 3.1x (optional, for installing 
from a NetWare server running IPX).

� IP Server Connection Utility (optional, for installing from a NetWare 
server running IP only). For instructions, see 
PRODUCTS\SERVERINST\IPCONN.TXT on the Novell Client 
CD.
Install a NetWare 5.1 Server ��
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� IP address and domain names (optional, for connecting to the Internet):

� An IP address

� An IP address of a Domain Name Server

� The name of your domain

���	
�For IP addresses and domain names, contact your system 
administrator and Internet Service Provider (ISP).

� Network board and storage device properties, such as the interrupt and 
port address. For more information, contact your computer hardware 
manufacturer.

Next, you should prepare the network for a NetWare 5.1 server. If this server 
is not being integrated into an existing network, you can skip to “Prepare the 
Computer” on page 17.

Prepare the Network

Before you introduce a NetWare 5.1 server into an existing network that 
contains NetWare 4 servers, you must run NetWare Deployment Manager to 
update the network.

���	
�A network consisting of only NetWare 3 servers does not need to be 
updated.

To update the network for NetWare 5.1, you must

� Log in from a Windows 95/98 or Windows NT workstation to your 
existing network as a user with Supervisor rights.

� Run NetWare Deployment Manager (NWDEPLOY.EXE), located on the 
NetWare 5.1 Operating System CD.

� Complete the following tasks in the Network Preparation section:

�� Back up NDS and server data.

�� Update NDS.

�� Prepare for NDS 8 (required if installing NetWare 5.1 with NDS 8).

�	 Install or update Novell Licensing Services.

After you have completed the Network Preparation section of NetWare 
Deployment Manager, you should now prepare the computer to be a NetWare 
server.
�� Installation Guide
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Prepare the Computer

To prepare your computer for NetWare 5.1, you must

� Install computer and networking hardware

� Create and format a DOS partition

� Access the installation files

Install Computer and Networking Hardware

Follow the manufacturer’s instructions to install and connect the network 
board and network cabling to your computer. Make sure that all storage 
devices are properly attached to storage adapters.

Create and Format a DOS Partition

NetWare requires a DOS partition with available disk space of at least 35 MB 
to start the computer and load NetWare. The DOS partition contains the 
NetWare startup and server files.

���	
�You should increase the size of your DOS partition to accomodate your 
specific configuration requirements.

 To create and format a DOS partition, complete the following steps.

� Back up any desired data to another computer or off-line storage media.

� If the computer already has an operating system installed, such as 
Windows, you should completely remove the partitions and the operating 
system.

���	
�Use FDISK to remove partitions.

� Boot your computer with DOS 3.3 or later.

���	
�You can boot from the NetWare 5.1 License/Cryptography diskette. DOS 7 
and all required DOS utilities are included on the diskette. Do not use the version 
of DOS that ships with Windows 95, Windows 98, or Windows NT operating 
systems.

� Use FDISK to create a 50 MB active DOS partition by entering FDISK. 
(Create a primary DOS partition, and make it the active partition.)

The computer will restart.

� Format and transfer DOS system files to the partition by changing to 
drive A: and entering FORMAT C: /S.
Install a NetWare 5.1 Server ��
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Your computer should now have an active DOS partition of at least 50 MB. 
Continue the installation by accessing the installation files.

Access the Installation Files

NetWare 5.1 can be installed from the server’s local CD drive or from 
installation files located on the network. To access the NetWare 5.1 
installation files, complete the following steps.

���	
�If you are using a bootable CD, skip to “Navigating in the Character-Based 
Screens” on page 18.

� Install the DOS CD driver for your CD drive onto the DOS partition. DOS 
CD drivers are provided by the CD drive manufacturer.

���	
�Make sure that the logical filename of your CD drive (specified in the 
CONFIG.SYS and AUTOEXEC.BAT files) is not CDROM or CDINST.

� Make sure that the CONFIG.SYS file contains the following commands: 
FILES=40 and BUFFERS=30.

� (Conditional) If you are installing from files located on a network, install 
the Novell Client for DOS and Windows 3.1x or IP Server Connection 
Utility software located on the Novell Client CD.

After accessing the files for the installation program, you can begin the 
installation.

Begin the Installation

To begin the installation, complete the following steps.

� Insert the NetWare 5.1 CD, or log in to the network and access the 
installation files on the network.

� At the CD drive or network drive prompt, enter INSTALL.

Navigating in the Character-Based Screens

The initial screens of the installation program display in text-based mode. 
Auto-detected and default settings appear on each screen.

You can accept the detected and default settings, or you can modify the 
settings to meet the needs of your networking environment.
�� Installation Guide
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����
 To continue the installation with the standard settings: Use the arrow keys 
to highlight Continue in the Options box. Press Enter.

To modify the settings: Use the arrow keys to highlight Modify in the Options box. 
Press Enter. Highlight the field to be modified. Press Enter. Select or enter the 
appropriate value.

Some screens require additional keystrokes in order to navigate through the 
interface. Information about screen navigation appears at the bottom of each 
screen.

Select the Type of Installation and Regional Settings

To select the type of installation and select regional settings, you must

� Select the language and accept the License Agreement

� Select the type of installation

� Specify server settings

� Select the regional settings

� Select the mouse and video type

Select the Language and Accept the License Agreement

The installation program is available in several languages. You can install 
other language options, such as the language for the operating system or for 
users, later during the installation program.

Accepting the License Agreement means that you have read and you accept 
terms and conditions contained in the License Agreement.

����
 Press F10 to accept the License Agreement.
Install a NetWare 5.1 Server ��
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Select the Type of Installation

You can install NetWare on a new computer or you can upgrade an existing 
computer running NetWare 3, NetWare 4, or NetWare 5.

����
 To select the type of installation: In the Options box, select Modify > Type of 
Installation > New Server. Return to the Options box to continue.

� New Server—installs a new server. Creates a new NetWare partition but 
will not delete system partitions or other partitions such as DOS, UNIX*, 
or Windows.

���	
�If the computer already has a NetWare partition, the new server installation 
will delete the NetWare partition containing volume SYS, and any other volumes 
that are part of that NetWare partition. If you want to keep volumes that are part of 
that NetWare partition, select Upgrade.

� Upgrade—If you are upgrading an existing server from a previous 
version of NetWare, select Upgrade. Upgrading retains all your server 
data such as files, directory structures, partitions, and volumes.

���	
�During an upgrade, the upgrade program may skip entire sections of this 
chapter. The upgrade program detects and automatically configures several of the 
tasks required to set up the server.

� Startup Directory—The startup directory is the directory on the DOS 
partition that contains the files to launch the NetWare server.
�
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Specify Server Settings

You can change the following default server settings for your networking 
environment.

� NDS Version—NetWare 5.1 allows you to install either NDS 8 or NDS 7.

� NDS 8—Provides the enhanced NDS functionality required by many 
new Web networking products, such as WebSphere. If your NDS tree 
has not already been updated for NDS 8, you must have Supervisor 
rights at the root of the NDS tree to install NDS.

� NDS 7—Provides basic NDS functionality without the requirement 
of modifying the NDS partition at the root of the NDS tree. Install 
NDS 7 if you do not have Supervisor rights at the root of the NDS 
tree or if the NDS tree has not already been modified for NDS 8.

���	
�Products that require NDS 8 will not be installed if you install NDS 7.

� Server ID Number—A unique server identification number (up to eight 
hexadecimal digits) identifies the server on the network. The server ID 
number functions like an internal IPXTM number. Although a server ID 
number is created automatically, you might need to enter a specific server 
ID number if you are installing in either of the following conditions:

� Filtered environment—Routers between network segments can be 
configured to forward data only from specific computer addresses. 
Data being sent from other computer addresses is not forwarded to 
other segments.

���	
�If you are accessing the installation files from a server on a different 
network segment, you might not be able to reconnect to the server to 
complete the installation unless you specify an unfiltered server ID number.

� Numbering scheme—Some network administrators set up a 
predetermined numbering scheme to identify servers in particular 
locations or organizations. For example, all servers in building A 
might begin with 0101, and all servers in building B might begin with 
0102.

� Load Server at Reboot—Select No if you do not want the 
AUTOEXEC.BAT and CONFIG.SYS files to contain the commands to 
automatically load the server operating system when the computer 
reboots. If you select Yes (default), the old AUTOEXEC.BAT and 
CONFIG.SYS files are renamed and saved with a .00x extension.
Install a NetWare 5.1 Server ��
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� Server SET Parameters—You might need to modify the SET 
parameters for some device drivers, such as for network boards and 
storage devices, in order to complete installation. SET parameters are 
saved to the STARTUP.NCF file.

Select the Regional Settings

Choose the country, code page, and keyboard mapping for your language and 
computer.
�� Installation Guide
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Select the Mouse and Video Type

���	
�The mouse type and video type are not auto-detected by the installation 
program. You must select the settings for the computer.

� Mouse Type—Choose a mouse type, if available on the computer. The 
installation program supports PS/2 or serial mouse types, but a mouse is 
not required.

� Video Type—The NetWare installation program is optimized to display 
with video display hardware that is VESA 2 compliant. Choose Standard 
VGA only if your video board does not support 256 colors.
Install a NetWare 5.1 Server ��
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Select a Platform Support Module and Storage Adapter

To select a platform support module and storage adapter, you must

� Select a platform support module (if required)

� Select a PCI Hot Plug module (if required)

� Select and configure a storage adapter

����
 To add a driver: In the Options box, select Modify. Select the driver and 
press Enter. Press Insert to select from a list of drivers provided with NetWare. 
Press Insert again to install a driver from diskette.

To delete a driver: In the Options box, select Modify. Select the driver and press 
Enter. Select the driver to delete and press Delete.

To modify a driver: In the Options box, select Modify. Select the driver and press 
Enter. Select the driver to modify and press Enter. Select the property to modify.

Select a Platform Support Module (If Required)

A platform support module (PSM) provides increased performance for multi-
processor computers and some specific hardware configurations. If a PSM 
driver is required, it will be auto-detected. If the installation program does not 
detect a PSM driver, your computer does not need one.
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���	
�If a PSM driver is detected on a computer without multiple processors, you 
can allow the driver to load without adversely affecting performance.

Select a PCI Hot Plug Module (If Required)

Computers that support PCI Hot Plug technology allow storage adapters and 
network boards to be inserted and removed while the computer is on. If the 
installation program does not detect a PCI Hot Plug support module, your 
computer probably does not support the PCI Hot Plug technology.

Select a Storage Adapter

A storage adapter is the adapter that plugs into the computer and provides a 
link between the computer and one or more storage devices. The storage 
adapter requires a software driver called a host adapter module (HAM) in 
order to communicate with the computer (host). Storage devices require a 
separate driver called a custom device module (CDM).

���	
�.DSK drivers are no longer supported. Instead, NetWare uses the 
enhanced capability of NetWare Peripheral ArchitectureTM (NWPA). NWPA 
requires a HAM and a CDM.

Because a single adapter can control more than one type of storage device, 
your computer might require only a single HAM, even though it can have 
more than one type of storage device—and therefore multiple CDMs.

The installation program auto-detects many types of storage adapters, such as 
IDE and SCSI adapters. If your storage adapter is not detected, choose the 
appropriate driver from the list of available drivers provided with NetWare 5.1 
or add a new driver from a diskette. You can obtain HAMs from the storage 
adapter manufacturer.

Edit the Properties of the Storage Adapter (If Required)

The storage adapter must be installed and configured correctly. Properties 
such as interrupt, port value, and slot must not conflict with any other device 
in the computer. If you need specific storage adapter properties, contact the 
storage adapter manufacturer.
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Select a Storage Device and a Network Board

To select a storage device and network board, you must

� Select and configure the storage device

� Select and configure the network board

� Load a NetWare Loadable ModuleTM program (if required)

����
 To add a driver: In the Options box, select Modify. Select the driver and 
press Enter. Press Insert to select from a list of drivers provided with NetWare. 
Press Insert again to install a driver from diskette.

To delete a driver: In the Options box, select Modify. Select the driver and press 
Enter. Select the driver to delete and press Delete.

To modify a driver: In the Options box, select Modify. Select the driver and press 
Enter. Select the driver to modify and press Enter. Select the property to modify.
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Select a Storage Device

Storage devices such as hard disks, CD drives, and tape devices require a 
software driver to communicate with the storage adapter. The software driver 
for the storage device is called a custom device module (CDM). Each type of 
storage device requires a CDM.

The installation program auto-detects many types of storage devices, such as 
IDE drives, SCSI drives, CD drives, and tape drives. If your storage device is 
not detected, choose the appropriate driver from the list of available drivers 
provided with NetWare 5.1 or add a new driver from a diskette. CDMs can be 
obtained from the storage device manufacturer.

Select a Network Board

Network boards, such as the Novell NE3200TM board, require a software 
driver in order to communicate with the network. The software driver for a 
network board is called a LAN driver.

The installation program auto-detects many types of network boards. If your 
network board is not detected, choose the driver for the network board from 
the list provided with NetWare 5.1 or add a new driver from a diskette. You 
can obtain LAN drivers from the network board manufacturer.

Edit the Properties of the Network Board (If Required)

The network board must be installed and configured correctly. Properties such 
as interrupt, port value, and slot must not conflict with any other device in the 
computer. If you need specific network board properties, contact the network 
board manufacturer.

Load a NetWare Loadable Module (If Required)

Some server and network configurations require you to load a NetWare 
Loadable Module (NLMTM) program before completing the server 
installation. For example, you can load ROUTE.NLM for installing in a token 
ring environment.
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Create a NetWare Partition and Volume SYS

Partitions correspond with operating systems, such as NetWare, DOS, or 
UNIX. Partitions divide a large storage region into smaller, more manageable 
sections. A single storage device can contain up to four partitions.

You can divide NetWare partitions into smaller sections called volumes. Each 
NetWare partition can contain up to eight volumes.

To create a NetWare partition and volume SYS, you must

� Remove an existing volume SYS (conditional)

� Create a NetWare partition

� Create volume SYS

� Set the size of the NetWare partition and volume SYS (if required)

� Modify the properties of volume SYS (if required)

Remove an Existing Volume SYS (Conditional)

If your server already has a volume SYS, the volume and all its data will be 
deleted.

���	
�To retain the data on volume SYS, you shoud exit and restart the 
installation program and select Upgrade from the Type of Installation screen.
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When removing volume SYS during a new server installation, you must 
choose one of the following options:

� Replace Volume SYS and its NetWare Partition—This will remove the 
existing volume SYS, as well as the entire NetWare partition containing 
volume SYS. Any volume that is part of the NetWare partition that 
contains volume SYS is also removed—even if the volume spans to other 
NetWare partitions.

� Remove All NetWare Volumes and NetWare/NSS Partitions—This 
will remove all NetWare volumes and all NetWare/NSS partitions.

Either option will remove only NetWare partitions. Other types of partitions, 
such as DOS, UNIX, and system/utility partitions, will not be removed.

Create a NetWare Partition

During the initial stages of installation, the installation program guides you 
through the steps to create a single NetWare partition containing volume SYS.

NetWare Partition Size—All available space on the storage device will be 
allocated to the NetWare partition, unless you change the size.

����
 To modify the NetWare partition size: In the Options box select Modify. 
Select the appropriate storage device. Select NetWare Partition Size and press 
Enter. Backspace over the current size. Type the new size and press Enter. Press 
F10 to save the settings and continue.
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���	
�NSS volumes use disk space outside of the NetWare partition. If you want 
to create NSS volumes, remember to reduce the size of the NetWare partition so 
that the appropriate amount of disk space is available for NSS volumes.

Hot Fix

Hot FixTM is a NetWare data protection feature that is optimized for your 
storage device. Hot Fix maintains a list of defective areas on the storage device 
and redirects data from defective locations to safe locations.

If your storage devices include hardware redirection, you can turn off Hot Fix 
by setting the Hot Fix size to 0. For more information on hardware redirection, 
contact your storage device vendor.

Create Volume SYS

The NetWare 5.1 operating system requires a volume of at least 750 MB 
named SYS. Although the NetWare operating system requires 750 MB, 
volume SYS must be large enough to accomodate all of the NetWare products 
that will be installed.

���	
�Volume SYS must be a traditional volume. It cannot be an NSS volume.

Table 1 Volume SYS Size

���	
�In addition to the sizes in the table, you should add as much as 100 MB to 
the volume SYS size. For optimal performance, volume SYS should always have 
available space for system operations.

Volume SYS size—By default, volume SYS will use all available space on the 
NetWare partition.

����
 To modify volume SYS size: In the Options box select Modify. Select the 
appropriate storage device. Select Volume SYS Size and press Enter. Backspace 
over the current size. Type the new size and press Enter. Press F10 to save the 
settings and continue.

���	
�If you plan to have additional volumes on the NetWare partition, remember 
to reduce the size of volume SYS so that the appropriate amount of disk space is 
available for other volumes.

NetWare 5.1 Products Minimum Volume SYS Size

Standard NetWare 5.1 products 750 MB

All NetWare 5.1 products 1.3 GB
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Edit Volume SYS Properties (If Required)

Although default settings work for most installations, you might need to 
modify volume properties such as block size, file compression, data 
migration, and suballocation.

����
 To modify the properties of volume SYS, press F3.

� Block size—Block size is automatically optimized for your server, based 
on the size of the volume. Typically, a larger block size optimizes the 
volume for large files.

� File compression—By default, compression is automatically enabled. 
Enabling compression maximizes disk space but increases the file access 
time.

���	
�Some backup programs cannot back up compressed files.

� Data migration—By default, data migration is automatically disabled. 
Data migration is used to identify inactive files and move them to near-
line storage systems, such as optical disks.

� Suballocation—By default, suballocation is automatically enabled. 
Suballocation allows more efficient use of disk space with only a slight 
increase in access time. Suballocation allows blocks to contain data from 
more than one file.
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Summary

NetWare system files will now be copied to volume SYS.

���	
�If you are installing from the network, you will be prompted to reconnect to 
the network. To continue the installation, enter the password for the user that 
originally logged in.

The NetWare 5.1 installation program will continue in graphical display 
mode.

Name the Server

The NetWare 5.1 server name must be unique from all other servers on the 
NDS tree. The name can be between 2 and 47 alphanumeric characters and can 
contain underscores and dashes, but no spaces. The first character cannot be a 
period.

���	
�The server name should be different from the name that you plan to use for 
the NDS tree.

Although a mouse is recommended, you can use the keyboard commands in 
Table 2 to navigate through the installation program. Use the arrow keys on 
the numeric keypad for cursor movements.
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���	
�NumLock (number lock) must be on in order for cursor movements to be 
enabled on the keypad.

Table 2 Graphical Mode Keyboard Actions

Keystroke Action

Tab Move focus to next element

Shift+Tab Move focus to previous element

Enter Select

Up-arrow (keypad 8) Move cursor up

Down-arrow (keypad 2) Move cursor down

Right-arrow (keypad 6) Move cursor right

Left-arrow (keypad 4) Move cursor left

Hold Shift while pressing keypad Accelerate cursor movement

Keypad 5 Select or click an object

Keypad 0 Lock a selected object (for dragging)

Keypad . (period) Unlock a selected object (to drop)

Keypad + (plus) Double-click an object

Alt+F7 Move to next window

Alt+F8 Move to previous window
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Install the NetWare Server File System

The server should now have a single NetWare partition and one volume named 
SYS. If you have space available for creating additional partitions and 
volumes, you can create them now.

���	
�If you have allocated all available space to volume SYS, you will not be 
prompted for NetWare server file system information. You can skip to “Install 
Networking Protocols” on page 39.

When installing the NetWare file system, you can

� Create additional volumes

� Modify volumes

� Delete volumes

Understand Volumes

Volumes allow you to subdivide your partitions into more manageable 
sections. You can create two types of volumes—traditional volumes or Novell 
Storage Services (NSS) volumes.

� Traditional NetWare volume—Traditional NetWare volumes support 
all NetWare volume technologies including suballocation, compression, 
and Transaction Tracking SystemTM (TTSTM).

� NSS volume—NSS is advanced file system technology that enhances the 
management of large files, large volumes, namespaces, and storage 
devices. The time required to mount large volumes is significantly 
reduced with NSS.

���	
�NSS volumes in NetWare 5.1 do not support data migration, data 
duplexing, disk mirroring, disk striping, file compression, transaction tracking, File 
Transfer Protocol (FTP), VREPAIR, Network File System (NFS*), or file name 
locks. If you require any of these technologies, use a traditional NetWare volume.
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Create Volumes

Additional volumes can be created from any available free space on a storage 
device. Volume names can be between 2 and 15 characters. Valid characters 
include A through Z, 0 through 9, and characters _ ! - @ # $ % & ( ). The 
volume name cannot begin with an underscore or have two or more 
consecutive underscores.

A large disk can be divided into several volumes during installation. 
Conversely, a volume can be distributed over multiple disks.

�������
�Creating a volume that spans two or more storage devices is not 
recommended. If a volume spans disk devices and one of the devices fails, all data 
on the entire volume could be lost.

Traditional volumes can be created from either traditional or unpartitioned 
free space. Both types of free space appear the same on the NetWare File 
System screen.
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����
 To create a traditional volume: Select free space and click Create. Type the 
name of the volume and click OK.

To allocate only a portion of the free space to the volume, type the amount of space 
to use, and click Apply to Volume.

To make the volume include additional free space, select an additional free space, 
type the amount of space to use, and click Apply to Volume.

NSS volumes can be created from unpartitioned free space.
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����
 To create an NSS volume: Select free space and click Create. (If the 
Volume Type option is not available, the selected free space is not available for 
NSS. Go back to the previous screen and select another free space.) Select 
Volume Type NSS. Type the name of the volume and click OK.

To allocate only a portion of the free space to the volume, type the amount of space 
to use, and click Apply to Volume.

To apply more free space to a volume, select an additional free space, type the 
amount of space to use, and click Apply to Volume.

Modify Volumes

The size of any existing volume can be increased but not decreased. To 
decrease the size of an existing volume, the volume must be deleted and 
re-created.

����
 To modify a volume: Select the volume to be modified. Click Modify.
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Delete Volumes

You can delete any volume you have created, except volume SYS. When a 
volume is deleted, all data on the volume is lost.

����
 To delete a volume: Select the volume to be deleted. Click Delete.

Mount Volumes

In order for volumes to be accessed by NetWare, they must be mounted. 
Volumes can be mounted immediately or at the end of installation.

���	
�Depending on their size, volumes can take a considerable amount of time 
to mount.

� Mount Volumes Now—You should mount volumes now if you plan to 
install additional products and services, such as documentation, on 
volumes other than volume SYS.

� Mount Volumes after Installation Completes—If you are installing 
products and services on volume SYS only, you can wait to mount 
volumes after the installation program completes.
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Install Networking Protocols

NetWare 5.1 can process IP (Internet Protocol) network packets and 
traditional IPX (Internetwork Packet ExchangeTM) packets. You can install 
networking protocols in the following ways:

� IP with IPX Compatibility Mode

� IP only

� IPX only

� IP and IPX

Protocols are assigned to network boards. Both protocols can be assigned to a 
single network board, which allows the server to communicate using IP and 
IPX.

����
 To install IP with IPX Compatibility: Click a network board. Check the IP 
check box. Enter the required IP information.

To install IPX: Click a network board, then check the IPX check box.
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Install IP with IPX Compatibility Mode

Internet protocol (IP) allows your network to share data with other IP 
networks, including the Internet. Using IP requires a unique IP address, a 
subnet, and a router or gateway address.

When IP is selected, passive support for IPX is also provided. If an IPX 
request arrives at the server, NetWare 5.1 will process the IPX request. This 
passive support for IPX is called Compatibility Mode and is automatically 
enabled to provide service for applications that require IPX.

� IP Address—An IP address identifies each device on the network. The 
address consists of 32 bits, which are represented as decimal values 
separated by periods, such as 123.45.67.89.

If your server will connect to the Internet, you must obtain a unique IP 
address. For information on receiving an IP address, contact your Internet 
service provider (ISP).

� Subnet Mask—Subnet masks allow you to break up your network into 
smaller networks. Your network might have too many nodes or might be 
too geographically dispersed to manage as a single network.

Dividing your network into smaller networks allows the network routers 
to filter and reduce the network activity seen by any of the nodes. 
However, dividing your network and using several network addresses 
might not be appropriate on a large network that needs to appear to 
network administrators as a single network.

� Router (Gateway)—The router (gateway) is the address of the router 
that connects two different environments, such as a LAN and the Internet.

You can enter a specific router (gateway) address, or you can rely on the 
network to automatically find the nearest router. If you specify the 
address, remember that the router must exist on your network segment.

Installing IP will automatically bind to the Ethernet_II frame type.
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Install IP Only

Internet Protocol (IP) can be installed without IPX Compatibility Mode 
enabled. When IPX Compatibility Mode is disabled, the server will process 
only IP packets. Applications that require IPX will not function properly.

���	
�You can also disable Compatibility Mode by removing the LOAD SCMD 
command from the server’s AUTOEXEC.NCF file.

Install IPX

Novell’s traditional protocol, Internetwork Packet Exchange (IPX), will allow 
you to continue using IPX-based applications. If only IPX is installed on your 
server, it will actively process IPX packets and ignore packets using other 
protocols, such as IP.

During the installation program, existing IPX frame types will be detected. 
The installation program will detect one of the following conditions.

� A single IPX frame type—If a single frame type is detected, it will be 
installed.

� Multiple IPX frame types—If detected, you will be prompted to choose 
the frame types that you want to install.

� No IPX frame types—If no frame types are detected, Ethernet_802.2 
will be installed by default.

Install Both IP and IPX

If you have network clients or applications that require IPX and IP, you can 
install both protocols. Both protocols can be bound to a single network board. 
When selected, both IP and IPX protocols are actively supported. The server 
will process IP requests using IP. The server will broadcast and reply to IPX 
requests using IPX.
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Set Up Domain Name Service

The IP protocol identifies computers and systems by their assigned IP 
addresses, such as 123.45.56.89. Domain Name Service (DNS) allows a 
specific server on the network to maintain a list of simple, readable names that 
match IP addresses. Applications (or protocols) that require IP addresses 
rather than names can use a DNS server to translate from one form to another.

���	
�If this server will not be available to the Internet, you can skip this screen 
and ignore any associated error messages.
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If you want this server to be available to the Internet, you must enter the 
following:

� Host Computer—The simple, readable name on the DNS server that 
matches this NetWare server’s name (or the name that you have bound to 
the network board).

����
 Set up the host computer name on the DNS server to use the NetWare 
server name.

� Domain Name—The hierarchical name that represents the organization 
of your network, such as acme.com.

� Domain Name Server—The IP address of the DNS server that maintains 
the list containing this NetWare server’s simple, readable name and IP 
address. For more information, contact your system administrator or 
Internet service provider.

(Optional) Configure a NetWare Server as a DNS Server

In addition to standard services, a NetWare server can be configured to 
provide DNS services.

To set up this NetWare server to provide DNS services:

� Complete the NetWare server installation.

� Log in to the NetWare server from a Windows workstation.

� Run SYS:PUBLIC\DNSDHCP\SETUP.EXE.

� Follow the on-screen instructions.
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Set the Server Time Zone

The server time and time zone are important in order to synchronize network 
events. Advanced time synchronization settings are available during the 
Customize section of the installation.

Set Up NDS, the Novell Directory Technology

NDS, the Novell directory technology, provides global access to all 
networking resources. NDS allows users with the proper access rights to log 
in to the network and view and access network resources.

Network resources such as servers and printers are presented hierarchically in 
an NDS tree. Users log in to the NDS tree with a single login name and 
password instead of logging in to specific servers.
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Choose the Type of NDS Installation

To set up NDS, you must choose one of the following options:

� Install the server into an existing NDS tree

� Create a new NDS tree

Before completing this task, you should understand the concepts relating to 
NDS trees, containers, and context.

� Tree—The NDS tree name is the top level of the available network 
resources and must be unique from other NDS tree names on the network.

� Containers—Container objects, much like subdirectories, contain 
network objects. The server can be installed into two types of container 
objects: Organization (O) and Organizational Unit (OU).

� Context—The context, much like DOS directory paths, denotes the full 
path of a network object in the NDS tree. For example, a NetWare server 
might be installed into an Organizational Unit (OU) named Sales under 
the organization (O) named Acme. The context would be denoted as 
OU=Sales.O=Acme or Sales.Acme.
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Install the Server into an Existing NDS Tree

Installing your server into the existing NDS tree incorporates the server into 
your network.

The server can be installed in any Organization (O) or Organizational Unit 
(OU) container in the NDS tree where you have Supervisor rights. You can 
create containers during the installation program. You will be required to log 
in and provide the context, username, and password for the user with 
Supervisor rights to the container.

���	
�If this is the first NetWare 5.1 server to be installed into an existing NDS 
tree, you should have already completed the Network Preparation section of the 
NetWare Deployment Manager utility.

NetWare Deployment Manager (NWDEPLOY.EXE) is located on the NetWare 
Operating System CD and is run from a Windows workstation.

If you have updated the NDS tree on all servers but have not yet prepared the 
network for NDS 8, you will be prompted to modify the schema. When prompted, 
you must provide the administrator name and password for the entire NDS tree.
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Create a New NDS Tree

Create a new tree if you are creating a new network or if this server requires a 
separate NDS tree. The resources available on the new tree will only be 
available to users logged in to the new tree.

Each NDS tree must have a name unique from other NDS trees on the 
network. You will also be prompted to create a user (default name Admin) 
with Supervisor rights, identify an NDS context, and assign a password.
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Summary

Now that you have created a new NDS tree or installed the server into an 
existing NDS tree, the NetWare Server object and Volume objects will be 
installed in the container you specified.

If you have created a new NDS tree, a user (default name Admin) with 
Supervisor rights to the NDS tree will be created in the same NDS container 
as the NetWare Server object.

���������
�Record the administrator password and other relevant information 
before proceeding.
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License the NetWare Server

NetWare 5.1 must have a valid license in order to function as a server. You can 
install the license from the NetWare 5.1 License/Cryptography diskette or 
browse to a directory that contains NetWare 5.1 licenses.

Install without Licenses—Although the server can be installed without a 
license, the unlicensed server will allow only two user connections. After 
installation, you can use the NetWare Administrator utility to install additional 
licenses.
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Install Networking Products

After completing the NetWare server portion of the installation, you can select 
other networking products to install. Other networking products provide 
enhanced functionality, such as network management and Internet access, to 
NetWare 5.1.

� Standard NetWare Products—The standard network products for 
NetWare 5.1 will be installed.

� Standard NetWare Products Plus Websphere Application Server for 
NetWare—In addition to the standard network products included in 
NetWare 5.1, IBM Websphere Application Server for NetWare will be 
installed.

� Custom—You select which NetWare products to install.

����
 To install a product, check the check box next to the product to be installed.
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Although you can choose which products to install, installing the products that 
are already selected by default will ensure that you receive the features 
recommended for NetWare.

Install Novell Certificate Server

Novell Certificate Server allows you to mint, issue, and manage digital 
certificates by creating a Security container object and an Organizational 
Certificate Authority (CA) object. The Organizational CA object enables 
secure data transmissions and is required for Web-related products such as 
NetWare Web Manager and NetWare Enterprise Web Server.

The first NetWare 5.1 server will automatically create and physically store the 
Security container object and Organizational CA object for the entire NDS 
tree. Both objects are created at, and must remain at the [Root] of, the NDS 
tree.

Only one Organizational CA object can exist in an NDS tree. Once the 
Organizatonal CA object is created on a server, it cannot be moved to another 
server. Deleting and re-creating an Organizational CA object will invalidate 
any certificates associated with the Organizational CA.

���������
�Make sure that the first NetWare 5.1 server is the server that you 
intend to permanently host the Organizational CA object and that the server will be 
a reliable, accessible, and continuing part of your network.
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���	
�To create the Security container object and the Organizational CA object, 
you must be logged in as a user with rights at [Root] of the NDS tree. 

If this is not the first NetWare 5.1 server on the network, the installation 
program will find and reference the NetWare 5.1 server that holds the 
Organizational CA object. The installation program will access the Security 
container and create a Server Certificate object.

���	
�To access the Security container and create a Server Certificate object, 
you must be logged in as a user with Read rights to the existing Security container 
object.

If an Organizational CA object is not available on the network, Web-related 
products such as NetWare Web Manager and NetWare Enterprise Web Server 
will not function.
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Customize the Installation

You can customize the installation of many products for your networking 
environment.

����
 To customize products and components: From the Summary screen, click 
Customize. Select the product to customize. Click Properties. Modify the product 
as required. Click OK.
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Complete the Server Installation

The basic server installation is now complete. Depending on which additional 
products you are installing, you might be prompted to insert additional CDs.

����
 From the Summary screen, click Finish to begin copying the files to the 
server. After all files are copied, the server must be rebooted in order for the 
settings to take effect.

����
 After the files are copied, click Yes to reboot the server.

NetWare 5.1 is automatically loaded when the computer reboots, or you can 
load it manually.
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����
 To load the server manually: Reboot the server by clicking Yes. Change to 
the startup directory containing the NetWare server files (C:\NWSERVER). Enter 
SERVER.

You should now upgrade your existing workstations or install new 
workstations with the latest Novell Client software. For more information, see 
“Install Novell Clients” on page 89.

You could also install and set up other networking products. For more 
information, see “Install Networking Products” on page 103.
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� Upgrade a NetWare Server to 
NetWare 5.1

The NetWare 5.1 installation program can be used to upgrade an existing 
NetWare® 3, NetWare 4, or NetWare 5 server to NetWare 5.1.

The upgrade process includes the following tasks:

� Meet system and software requirements

� Prepare the network and the computer

� Specify hardware and software settings

� Create additional volumes (if required)

� Select and install networking protocols

� Set up NDS®, the Novell® directory technology (if required)

� Install other networking products

During the upgrade program, the server is upgraded to NetWare 5.1 by 
automating the following tasks:

� Device drivers and LAN drivers for the NetWare 5.1 operating system are 
loaded. Outdated drivers are matched with and replaced by new drivers 
included with NetWare 5.1.

� NDS is installed or upgraded, depending on which NetWare version you 
are upgrading.

� NetWare 5.1 information is added to the AUTOEXEC.NCF and 
STARTUP.NCF files.

� The NetWare 5.1 files are copied to the server.

� Novell Distributed Print ServicesTM (NDPS® ) is installed.
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���	
�Upgrading to NetWare 5.1 will disable queue-based printing. To enable 
printing, you should install and set up NDPS after upgrading to NetWare 5.1.

Meet System and Software Requirements

System Requirements

To upgrade to NetWare 5.1, your system must meet the following minimum 
requirements:

���	
�The system requirements listed below are minumum requirements. You 
can optimize the server performance by increasing the amount of server memory, 
disk space, and other components.

� A server-class PC with a Pentium* II or higher processor.

� The server to be upgraded must be running NetWare 3.1x, NetWare 4.1x, 
or NetWare 5.0.

� A VGA or higher resolution display adapter (SVGA recommended).

� 35 MB of available disk space on the DOS partition.

� Minimum disk space requirement on volume SYS:

� Standard NetWare products and WebSphere* Application Server for 
NetWare—1.3 GB.

� Minimum memory requirements:

� Standard NetWare products—128 MB.

� NetWare products plus WebSphere Application Server for 
NetWare—256 MB (512 MB recommended).

� All products including Oracle8—512 MB.

� One or more network boards.

� A CD drive. Bootable CD drives must support the El Torito specification.

� A PS/2* or serial mouse is recommended, but not required.

���	
�If your existing computer does not meet the minimum requirements, you 
may want to use Novell Upgrade Wizard to migrate files to another computer. See 
the “Using Novell Upgrade Wizard” on page 63.
�� Installation Guide

Installation Guide
100-004513-001 A
December 14, 1999
Novell Confidential



doc_tpl.fm Rev 99a 22 November 99
Software and Other Requirements

Before installing, make sure that you have the following software and 
information:

� If this is the first NetWare 5.1 server on the network, you must:

� Make sure that this server will be a reliable, accessible, and 
continuing part of your network.  

���	
�The first NetWare 5.1 server will automatically create and physically 
store the Organizational Certificate Authority (CA) object for the entire NDS 
tree. The Organizational CA object enables secure data transmissions and is 
required for Web-related products such as NetWare Web Manager and 
NetWare Enterprise Web Server. 

���������
�Once created, you should not delete or move the 
Organizational CA object.

� Have Supervisor rights at the [Root] of the NDS tree

� If this is not the first NetWare 5.1 server on the network, you must:

� Have Supervisor rights to the container where the server will be 
installed.

� Have Read rights to the Security container object for the NDS tree.

� NetWare 5.1 Operating System CD.

� NetWare 5.1 License/Cryptography diskette.

� DOS 3.3 or later installed on the bootable DOS partition.

���	
�Do not use the version of DOS that ships with Windows* 95, Windows 98, 
or Windows NT* operating systems. DOS 7 is included on the NetWare 5.1 
License diskette.

� DOS CD drivers.

� Client connection utilities (optional, for upgrading from a network):

� Novell ClientTM for DOS and Windows 3.1x (optional, for upgrading 
from a NetWare server running IPX).

� IP Server Connection Utility (optional, for upgrading from a 
NetWare server running IP only). For instructions, see 
PRODUCTS\SERVERINST\IPCONN.TXT on the Novell Client 
CD.
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� IP address and domain names (optional, for connecting to the Internet):

� An IP address.

� An IP address of a Domain Name Server.

� The name of your domain.

���	
�For IP addresses and domain names, contact your system 
administrator and Internet Service Provider (ISP).

� Network board and storage device properties, such as the interrupt and 
port address. For more information, contact your computer hardware 
manufacturer.

Next, you should prepare the network to receive a NetWare 5.1 server. If this 
server is the only server on the network, you can skip to “Prepare the Server 
for the NetWare 5.1 Upgrade” on page 61.

Prepare the Network

Before you introduce a NetWare 5.1 server into an existing network that 
contains NetWare 4 servers, you must run NetWare Deployment Manager in 
order to update the network.

���	
�A network consisting of only NetWare 3 servers does not need to be 
updated.

To update the network for NetWare 5.1, you must

� Log in from a Windows 95/98 or Windows NT workstation to your 
existing network as a user with Supervisor rights.

� Run NetWare Deployment Manager (NWDEPLOY.EXE), located on the 
NetWare 5.1 Operating System CD.

� Complete the following tasks in the Network Preparation section:

�� Back up NDS and server data.

�� Update NDS.

�� Prepare for NDS 8 (required if installing NetWare 5.1 with NDS 8).

�	 Install or update Novell Licensing Services.

After you have completed the Network Preparation section of NetWare 
Deployment Manager, you should now prepare the computer to be a NetWare 
server.
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Prepare the Server for the NetWare 5.1 Upgrade

To prepare your existing server for the NetWare 5.1 operating system:

� Back up the NetWare server files

� Verify a valid DOS partition

� Access the upgrade program

Back Up the NetWare Server Files

Make at least one backup of your NetWare server files, including files on the 
DOS partition. Do not attempt an upgrade without a backup.

Verify a Valid DOS Partition

Your NetWare server uses a DOS partition to start the computer and load 
NetWare. Many of the existing NetWare startup files will be replaced with 
new NetWare 5.1 files. In addition, the DOS partition must have 35 MB of 
available space to accommodate new NetWare 5.1 files.

���	
�If the DOS partition does not have 35 MB of available space, you cannot 
upgrade the server. You must create a new DOS partition and install a new server. 
See “Install a NetWare 5.1 Server” on page 13.

Access the Installation Files

Your NetWare server can be upgraded from the server’s local CD drive or 
from installation files located on the network. Before you can access the 
NetWare 5.1 installation program, you must complete the following steps.

� Install the DOS CD driver for your CD drive onto the DOS partition. DOS 
CD drivers are provided by the CD drive manufacturer.

���	
�Make sure that the logical filename of your CD drive (specified in the 
CONFIG.SYS and AUTOEXEC.BAT files) is not CDROM or CDINST.

� Install Novell ClientTM software (conditional, if upgrading using 
installation files located on a network).

� Make sure that the CONFIG.SYS file contains the following commands: 
FILES=40 and BUFFERS=30.

� (Conditional) If you are installing from files located on a network, install 
the Novell Client for DOS and Windows 3.1x or IP Server Connection 
Utility software located on the Novell Client CD.
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After installing and accessing the CD, you can begin the upgrade by inserting 
the NetWare 5.1 CD or by accessing the installation program on the network 
drive.

What’s Next

After accessing the NetWare 5.1 installation program, follow the instructions 
for installing a server beginning with “Begin the Installation” on page 18.

����
 Don’t forget to select Upgrade as the type of installation.
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� Using Novell Upgrade Wizard

Novell® Upgrade Wizard helps you copy the files and objects from an existing 
server running NetWare® to another server running a later version of NetWare.

���	
�These instructions describe how to migrate data from a NetWare 3 or 
NetWare 4 server to a NetWare 5.1 server; however limited instructions are also 
provided on how to migrate NetWare 3 or NetWare 4 data to a NetWare 5.0 server.

The following figure shows Novell Upgrade Wizard managing the migration 
of data from a NetWare 3 server to a NetWare 5.1 server.

NetWare 3
server

NetWare 5.1
server

Windows  95/98
or

Windows NT 4.0
workstation

Data

Novell
Upgrade
Wizard

files
volumes
objects
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Migrating NetWare 3 data to NetWare 5.1. Novell Upgrade Wizard copies 
the NetWare 3 file system and bindery objects to another server running 
NetWare 5.1. When the bindery objects are copied to the NetWare 5.1 
destination server, they are placed in the NDS® tree and automatically 
converted to NDS objects. Novell Upgrade Wizard will not migrate data from 
a NetWare 3.x source server to a NetWare 4.10 destination server. Valid 
destination servers are NetWare 4.11, 4.2, 5.0 and 5.1.

If you are migrating data from NetWare 3, go to “Migrate Data from NetWare 
3 to NetWare 5.1” on page 65.

Migrating data from NetWare 4 to NetWare 5.1. Novell Upgrade Wizard 
migrates files and NDS information from a NetWare 4 server to a faster, more 
reliable computer running NetWare 5.1. After NDS is migrated, the NetWare 
5.1 destination server replaces and assumes the identity of the NetWare 4 
source server on the network.

If you are migrating data from NetWare 4, go to “Migrate Data from NetWare 
4 to NetWare 5.1” on page 70.
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Migrate Data from NetWare 3 to NetWare 5.1

To copy the data from an existing NetWare 3.x server to NetWare 5.1, you 
must:

� Meet system and software requirements

� Prepare the NetWare 3 source server

� Prepare the NetWare 5.1 destination server

� Run Novell Upgrade Wizard

� Select files and objects to migrate to the destination server

� Migrate the objects to the destination server

� Perform post-migration procedures

Meet System and Software Requirements

Novell Upgrade Wizard requires the following system and software 
configuration:

� A Windows* 95/98 or Windows NT* (4.0 or later) workstation with 
50 MB of available disk space.

� The Windows 95/98 workstation must be running Novell Client for 
Windows 95/98 version 3.1 or later with Support Pack 1 or later or 
ZENworksTM 2.0.

� The Windows NT workstation must be running Novell Client for 
Windows NT version 4.6 or later with Support Pack 1 or later.

� A source server running the NetWare 3.11, 3.12, or 3.2 operating system, 
and the latest updates.

���	
�Updates are available at the Novell Support Connection® Web site (http://
www.support.novell.com). Search for the support pack by entering the name into 
the Quick Search field.

� A destination server running the NetWare 5.1 operating system.

� A client connection to the source and destination servers using the IPXTM 
protocol.
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� Make sure that the source server, destination server, and client 
workstation are running on a common LAN segment (IPX external 
network number).

If it is impossible for the destination server and source server to be on a 
common LAN segment, disable SAP filtering between the source and 
destination servers.

� Source and destination servers running the IPX protocol.

� Supervisor or supervisor-equivalent rights, including Console Operator 
rights, to the containers where both the source and destination servers 
reside.

Continue with “Prepare the NetWare 3 Source Server.”

Prepare the NetWare 3 Source Server

The source server is the computer that contains the data—such as files, 
volumes, and bindery objects—that will be copied and migrated to the 
destination server. Valid NetWare 3 source servers can be running 
NetWare 3.11, 3.12, or 3.2.

To prepare a NetWare 3 source server:

� Back up all data.

� Verify that you have Supervisor rights to the container where the source 
server resides.

� If the source and destination servers are not running on a common LAN 
segment, disable SAP filtering between the source and destination server.

To disable SAP filtering, load INETCFG at the server console and go to 
Protocols > IPX > Filtering Support. If SAP filtering cannot be disabled, 
you should ensure that the default server (preferred server) for the 
workstation is on the same LAN segment as the destination and source 
server.

� Continue with “Prepare the NetWare 5.1 Destination Server.”
�� Installation Guide

Installation Guide
100-004513-001 A
December 14, 1999
Novell Confidential



doc_tpl.fm Rev 99a 22 November 99
Prepare the NetWare 5.1 Destination Server

The destination server is the server that receives the data migrated from the 
source server. After data is copied from a NetWare 3 server, it appears in the 
destination server’s NDS tree. Valid destination servers can be running 
NetWare 4.11, 4.2, 5.0, or 5.1.

To prepare a destination server to receive data from a NetWare 3 source server:

� Identify an existing destination server, or install a new destination server 
by following the NetWare 5.1 installation instructionts.

���	
�If you are migrating data to a version of NetWare other than NetWare 5.1, 
update the destination server with the latest software from the Novell Support 
Connection Web site (http://www.support.novell.com). Search for the following 
updates by entering the name of the NetWare Support Pack into the Quick Search 
field:

� NetWare 5.0 requires NetWare 5 Support Pack 3 (NW5SP3a.EXE) or 
later.

� NetWare 4.11 and 4.2 require NetWare 4 Support Pack 6a 
(IW4SP6A.EXE) or later.

���������
�Novell Upgrade Wizard does not support upgrades from 
NetWare 3.x to NetWare 4.10.

� Verify that the destination server has enough disk space to accommodate 
the files and directories moving from the source server.

� Ensure that the destination server is running the IPX protocol.

� Back up NDS and all data.

� Continue with “Run Novell Upgrade Wizard.”

Run Novell Upgrade Wizard

To run Novell Upgrade Wizard:

� Insert the NetWare 5.1 Operating System CD into the CD drive of your 
Windows 95/98 or Windows NT workstation.

� Run Novell Upgrade Wizard (Products\upgrdwrd\UPGRDWRD.EXE), 
located on the NetWare 5.1 Operating System CD.

���	
�If this is the first time that you have run Novell Upgrade Wizard, when you 
click the Novell Upgrade Wizard executable, it will launch an installation program 
before you can actually run the application. The installation program, by default, 
installs Novell Upgrade Wizard at this location: Start menu > Programs > Novell > 
Novell Upgrade Wizard > Novell Upgrade Wizard.
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� Create a new project. This requires naming and saving the project and 
logging in to the source and destination trees.

� Continue with “Select Files and Objects to Migrate to the Destination 
Server.”

Select Files and Objects to Migrate to the Destination Server

The designated source server’s bindery objects and volume data and the 
destination server’s NDS tree are displayed in the Project Window.

To begin the migration process, first determine which NetWare 3 bindery 
objects and volume data will be copied to which containers on the destination 
server’s NDS tree, then complete the following steps:

� Drag the bindery and volume objects from the source server and drop the 
bindery into containers and the volumes into folders on the destination 
NDS tree.

To create a new NDS Organizational Unit (also called a container), right-
click on the parent of the Organizational Unit.

To create a new folder, right-click on an existing folder.

� Verify that the data can be copied.

To verify, click Project > Verify Project.

���������
�All critical errors must be corrected before you migrate NDS. 
Warning errors can be fixed after migration.

� Continue with “Migrate the Objects and Volumes to the Destination 
Server’s NDS Tree.”

Migrate the Objects and Volumes to the Destination Server’s NDS 
Tree

Although you have selected the containers where the NetWare 3 data will be 
copied, no data has yet been migrated. When migrated, the bindery data is 
converted to NDS objects and placed in the NDS tree on the destination server.

To migrate the objects and volumes to the destination server:

� Click Project > Migrate.

� Continue with “Perform Post-Migration Tasks.”
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Perform Post-Migration Tasks

After migrating the files and objects to the destination server, you should:

� Modify the print configuration.

For more information, see the Novell Distributed Print Services 
Administration Guide.

� Make sure that applications have migrated correctly.

After migration, if you want to install additional network products and 
services, go to the NetWare Deployment Manager utility 
(NWDEPLOY.EXE) located at the root of the NetWare 5.1 Operating 
System CD, and select Post-Installation Tasks > Install NetWare 5.1 
Products.

You can also install additional network products from the server console 
by clicking the red Novell button on the servertop.

� Make sure that user information has migrated correctly.

� Modify the container and user login scripts to accommodate the new NDS 
tree that has been introduced into the network.

For more information, see Setting Up Login Scripts in Novell Client for 
Windows.
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Migrate Data from NetWare 4 to NetWare 5.1

When you migrate data from NetWare 4 to NetWare 5.1, you must first install 
a new NetWare 5.1 server in a temporary NDS tree. Once this is done, Novell 
Upgrade Wizard copies the files and data from the NetWare 4 server to the 
newly installed NetWare 5.1 server and migrates the NetWare 4 NDS 
information to the NetWare 5.1 server.

After the NetWare 4 NDS data is migrated to the new NetWare 5.1 server, the 
NetWare 4 source server will automatically be brought down and the NetWare 
5.1 server will reboot. The NetWare 5.1 server will appear in the same NDS 
container with the same name as the NetWare 4 source server.

To upgrade from NetWare 4 to NetWare 5.1, you must:

� Plan your migration process

� Meet system and software requirements

� Prepare the network 

� Prepare the NetWare 4 source server

� Prepare the NetWare 5.1 destination server

� Run Novell Upgrade Wizard

� Perform post-migration tasks
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Plan Your Migration Process

You should start by migrating one replica ring at a time.

� First, migrate the server that contains the Master replica of [Root].

� Next, migrate all Read/Write replicas within that same replica ring.

� Then, migrate all Read-Only replicas within that same replica ring.

� Migrate all servers without replicas last.

� After you have migrated the replica ring that contained the Master replica 
of [Root], migrate each replica ring in this order: Master replicas, Read/
Write replicas, Read-Only replicas, and servers without replicas.

Continue with “Meet System and Software Requirements.”

Meet System and Software Requirements

Novell Upgrade Wizard requires the following system and software 
configuration.

� A Windows 95/98 or Windows NT (4.0 or later) workstation with 50 MB 
of available disk space.

� The Windows 95/98 workstation must be running Novell Client for 
Windows 95/98 version 3.1 or later with Support Pack 1 or later or 
ZENworks 2.0.

� The Windows NT workstation must be running Novell Client for 
Windows NT version 4.6 or later with Support Pack 1 or later.

� A NetWare 4 source server running the NetWare 4.10, 4.11, or 4.2 
operating system, and the latest updates. Updates are available at the 
Novell Support Connection Web site (http://www.support.novell.com). 
Search for the support pack by entering the name into the Quick Search 
field.

� NetWare 4.10 requires 410PT8B.EXE, DS410P.EXE, LIBUPI.EXE, 
STRTL7.EXE, and SMSUP6.EXE or later. Copy these files to the 
SYS:SYSTEM directory.

� NetWare 4.11 and 4.2 require NetWare 4 Support Pack 6a 
(IW4SP6A.EXE) or later.
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� Verify that the NetWare 4 source server is running long namespace 
support for Windows 95/98 and Windows NT on all volumes to be 
copied.

To add long namespace support to a NetWare 4.11 or NetWare 4.2 server, 
at the server console, enter LOAD LONG, then enter ADD NAME SPACE 
LONG TO volumename. To add long namespace support to a 
NetWare 4.10 server, at the server console, enter LOAD OS2, then enter 
ADD NAME SPACE OS2 TO volumename.

� A destination server running the NetWare 5.1 operating system (NetWare 
5.1 requires 128 MB of RAM).

� If the destination server will be the first NetWare 5.1 server in the NDS 
partition, the NetWare 4 source server must have a Read/Write or Master 
NDS replica prior to migrating.

� A client connection to the source and destination servers using the IPX 
protocol.

� Make sure that the source server, destination server, and client 
workstation are running on a common LAN segment (IPX external 
network number).

If it is impossible for the destination server and source server to be on a 
common LAN segment, disable SAP filtering between the source and 
destination servers.

� Source and destination servers running the IPX protocol.

� Make sure no other network products besides Storage Management 
ServicesTM (SMSTM), LDAP, Novell Certificate Server, and NetWare 
Management PortalTM are installed on the NetWare 5.1 destination server.

� Supervisor or supervisor-equivalent rights, including Console Operator 
rights, to the container where the source and destination servers reside.

Continue with “Prepare the Network.”
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Prepare the Network

Before introducing a NetWare 5.1 server into an existing network containing 
NetWare 3 or NetWare 4 servers, you must run NetWare Deployment Manager 
in order to update the network.

To update the network for NetWare 5.1:

� Log in from a Windows 95/98 or Windows NT workstation to your 
existing network as a user with Supervisor rights to the container where 
the source and destination servers reside.

� Run NetWare Deployment Manager utility (NWDEPLOY.EXE), located 
at the root of the NetWare 5.1 Operating System CD.

� Complete the following tasks in the Network Preparation section:

�� Back up NDS® and server data.

�� Update NDS.

�� Prepare for NDS 8 (required only if installing NetWare 5.1 with 
NDS 8).

�	 Install or update Novell Licensing Services.

Continue with “Prepare the NetWare 4 Source Server.”

Prepare the NetWare 4 Source Server

The source server is the NetWare 4 server that contains the files, volumes, and 
NDS objects that will be copied to the NetWare 5.1 destination server. Valid 
NetWare 4 source servers can be running NetWare 4.10, 4.11, or 4.2.

To prepare a NetWare 4 source server:

� Verify that you have supervisor rights to the container where the source 
server resides.

To verify supervisor rights, use NetWare Administrator.

� If the destination server will be the first NetWare 5.1 server in the NDS 
partition, make sure that the NetWare 4 source server has a Read/Write or 
Master NDS replica.

To verify replica status, use NDS Manager (NDSMGR16.EXE).
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� Update the source server with the latest software.

� NetWare 4.10 requires 410PT8B.EXE, DS410P.EXE, LIBUPI.EXE, 
STRTL7.EXE, and SMSUPG.EXE or later. Copy these files to the 
SYS:SYSTEM directory.

� NetWare 4.11 and 4.2 require NetWare 4 Support Pack 6a 
(IW4SP6A.EXE) or later.

� Make sure that long namespace support is running on all volumes to be 
copied.

To add long namespace support to a NetWare 4.11 or NetWare 4.2 server, 
at the server console, enter LOAD LONG, then enter ADD NAME SPACE 
LONG TO volumename. To add long namespace support to a 
NetWare 4.10 server, at the server console, enter LOAD OS2, then enter 
ADD NAME SPACE OS2 TO volumename.

� Load DSREPAIR and run Unattended Full Repair.

Make sure that Unattended Repair, Time Synchronization, and Report 
Synchronization Status finish with no errors.


 Back up NDS and all data.

� If the source and destination servers are not running on a common LAN 
segment, disable SAP filtering between the source and destination 
servers.

To disable SAP filtering, load INETCFG at the server console and go to 
Protocols > IPX > Filtering Support. If SAP filtering cannot be disabled, 
you should ensure that the default server (preferred server) for the 
workstation is on the same LAN segment as the destination and source 
server.

� Continue with “Prepare the NetWare 5.1 Destination Server.”
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Prepare the NetWare 5.1 Destination Server

The destination server is the new computer that will receive the data from the 
source server. After data is migrated from a NetWare 4 source server to a 
NetWare 5.1 destination server, the destination server will reboot and assume 
the name and identity of the NetWare 4 source server on the network.

To prepare a NetWare 5.1 destination server to receive data from a NetWare 4 
source server:

� Install a new server with the NetWare 5.1 operating system by following 
the NetWare 5.1 installation instructions. (See Chapter 1, “Install a 
NetWare 5.1 Server,” on page 13.)

Select the Custom option and make sure that no other network products 
besides Storage Management Services (SMS), LDAP, Novell Certificate 
Server, and NetWare Management PortalTM are selected.

���������
�When you install NetWare 5.1, four network products—SMS, 
LDAP, Novell Certificate Server, and NetWare Management Portal—are 
automatically installed. During migration, the NDS objects for SMS, LDAP, and 
Novell Certificate Server, as well as any applications that have files or NLM 
programs located in the SYS:SYSTEM directories, are removed from the NDS 
tree.

Although the NDS objects are removed, the NLM programs for these products still 
exist. Because you cannot manage applications without their corresponding NDS 
objects, you must reinstall the applications to restore their NDS objects to the NDS 
tree.

Reinstall these applications after NDS has been migrated. See “Perform Post-
Migration Tasks” on page 78.

� Enter a temporary name for the NetWare 5.1 server.

���������
�The temporary name and temporary NDS tree name must not be 
the same as the source server’s name or NDS tree name; otherwise, the 
destination server, after migration, will not assume the name of the source server.

� Create a temporary NDS tree with a temporary NDS tree name.

� Create a volume SYS on the destination server that is the same size, or 
larger than, volume SYS on the source server.

Volume names and sizes on the destination server must be the same as the 
volume names and sizes on the source server.

� Install and configure the IPX protocol.

The IPX protocol must be installed on the destination server for the 
migration. (You can remove IPX after completing the migration.)
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���������
�IP addresses for the source server will not be migrated.

If you want to use the same IP address on the destination server, in the Edit 
Configuration Files window of Novell Upgrade Wizard, copy the source server’s 
address and paste it into the destination server’s AUTOEXEC.NCF file.

To simply modify the IP Address, use INETCFG.NLM on the destination server.


 Continue with “Run Novell Upgrade Wizard.”

Run Novell Upgrade Wizard

To run Novell Upgrade Wizard:

� Insert the NetWare 5.1 Operating System CD into the CD drive of your 
Windows 95/98 or Windows NT workstation.

� Run Novell Upgrade Wizard (Products\upgrdwrd\UPGRDWRD.EXE), 
located on the NetWare 5.1 Operating System CD.

���	
�If this is the first time you have run Novell Upgrade Wizard, when you click 
the Novell Upgrade Wizard executable, it will launch an installation program before 
you can actually run the application. The installation program, by default, installs 
Novell Upgrade Wizard at this location: Start menu > Programs > Novell > Novell 
Upgrade Wizard > Novell Upgrade Wizard.

� Create a new project. This requires naming and saving the project, and 
logging in to the source and destination trees.

� Click Copy Volumes.

You do not need to copy all volumes at once. You can select volumes to 
copy now and copy other volumes later by reopening the project file.

���������
�If you choose not to migrate a volume, once NDS is migrated from 
the NetWare 4 source server to the NetWare 5.1 destination server, you will lose 
the trustee assignments for the volume that you chose not to migrate.

If you have big volumes, slow LAN connections, source and destination 
servers on different LAN segments, or if you want to reconfigure your 
data by putting existing directories into different folders on the 
destination server, you may consider using a backup tape to copy your 
volumes. To use a tape backup:

� Deselect all volumes on the Volumes to Copy screen in Novell 
Upgrade Wizard.

� Use your backup software to back up your volumes to a backup tape 
and continue the Novell Upgrade Wizard procedures of editing the 
configuration files and migrating the NDS.
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���	
�If you use a tape backup to copy your volumes, restore the volume data 
after NDS is migrated to the NetWare 5.1 destination server. Once the volume data 
is restored, complete the post-migration tasks.

���������
�When you installed NetWare 5.1 on the destination server, the 
SYS:SYSTEM and SYS:PUBLIC directories were created for you. Do not restore 
the source server’s SYS:SYSTEM and SYS:PUBLIC directories to the NetWare 
5.1 destination server.

� (Optional) Click Edit Configuration Files.

Novell Upgrade Wizard allows you to modify any NCF files on the 
NetWare 5.1 destination server. These files contain default LOAD 
statements and parameters.

If the source server was running an NLM program or application that you 
want to run on the destination server, copy and paste the commands from 
the configuration file on the source server to the corresponding 
configuration file on the destination server. Make sure that the application 
is compatible with NetWare 5.1.


 Click NDS Migration > Migrate NDS.

After you click Migrate NDS, Novell Upgrade Wizard will instruct you 
to run DSREPAIR, copy the NICI configuration files (if coming from a 
BorderManagerTM 4.x server), select a licensing option, confirm 
passwords, and resolve all critical errors. Warning errors can be resolved 
after the NDS migration.

At the end of this step, the NetWare 4 server will be brought down and the 
NetWare 5.1 server will reboot and assume the name and identity of the 
NetWare 4 server.

� Click Continue NDS Migration.

���������
�When the NetWare 5.1 server reboots, you may see warnings on 
the server console of the destination server regarding the four default network 
products—SMS, LDAP, Novell Certificate Server, and NetWare Management 
PortalTM—that were installed with the NetWare 5.1 operating system. Ignore the 
warnings and reinstall the products after the NDS has been migrated.

�� Make sure that the NetWare 5.1 destination server has restarted and 
taken over the identity and name of the NetWare 4 source server.

�� Wait approximately 30 minutes for the NDS tree to synchronize.
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�� Make sure that time synchronization on the NetWare 5.1 server 
matches time synchronization on all other servers in the NDS tree.

To check NDS synchronization status, enter DSREPAIR at the server 
console and select Report Synchronization Status. If the NetWare 5.1 
destination server does not contain a Read/Write or Master replica, 
you must check NDS synchronization by running DSREPAIR on 
another server in the NDS tree that has a Read/Write or Master 
replica.

If NDS is not synchronized, enter the following commands at the 
NetWare 5.1 server console:

SET DSTRACE=ON

SET DSTRACE=*U

SET DSTRACE=*H

SET DSTRACE=+SYNC

�	 Resolve any Novell Licensing Services errors recorded in the 
NUW.ERR error log file.

To view the error log file, enter EDIT SYS:SYSTEM/NUW30/
NUW.ERR at the server console.

�
 After meeting the conditions listed above, click Migrate.

Continue with “Perform Post-Migration Tasks.”

Perform Post-Migration Tasks

After upgrading the server, you should:

� Run DSREPAIR on the NetWare 5.1 server and select Unattended Full 
Repair.

� Make sure that user information migrated successfully.
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� Make sure that products and applications migrated successfully.

� Reinstall SMS, LDAP, and Novell Certificate Server.

Go to the server console and click the red Novell button on the 
servertop.

� Reinstall any applications that have files or NLM programs 
associated with the following volume SYS directories: SYSTEM, 
PUBLIC, MAIL, ETC, and NETBASIC.

To reinstall these network products and services, go to the NetWare 
Deployment Manager utility (NWDEPLOY.EXE), located on the 
NetWare 5.1 Operating System CD, and select Post-Installation 
Tasks > Install NetWare 5.1 Products.

If your NetWare 4.x source server was a BorderManager server, complete the 
following:

� Disconnect the NetWare 4 source server from the network.

� Restart the server by entering RESTART at the DOS prompt.

� Load the NUWNICI0.NLM program at the server console.

� Follow the on-screen instructions.

Troubleshooting

If you are unable to reconnect to the NetWare 5.1 destination server after it 
reboots, see “Unable to Reconnect to the Destination Server After It Has 
Rebooted” on page 80.

In some cases, migration of data to the destination server may fail. If this 
occurs, you will need to restore the NetWare 4 server and the destination 
server to their original configuration before you try again to migrate data to 
the destination server.

� If the migration failed and your server was in an NDS tree with multiple 
servers, go to “Restore the NetWare 4 Server to Its Original 
Configuration—Multiserver Tree” on page 81.

� If the migration failed and your server was the only server in an NDS tree, 
go to “Restore the NetWare 4 Server to Its Original Configuration—
Single-Server Tree” on page 87.
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Unable to Reconnect to the Destination Server After It Has Rebooted

���	
�If the NetWare 4 server and the NetWare 5 server are on different LAN 
segments, you may not be able to reconnect until the router table updates itself. 
The router table update may take several minutes. Try logging in again after the 
NetWare 5.1 server restarts.

During the Migrate NDS portion of a NetWare 4 to NetWare 5.1 upgrade, if 
you fail to reconnect after the destination server reboots:

� Locate a server containing an NDS partition of the destination server.

� At the console of that server, enter LOAD DSREPAIR.

� Make sure that the Time Synchronization and Report Synchronization 
Status programs report that the server is synchronized.

If the time synchronization has errors, there may be communication 
problems between the source and destination servers. To check your 
server-to-server communication, go to the server console of the source 
server and run IPX PING (IP PING if you have a NetWare 5.0 server with 
IP); follow the on-screen prompts.

For more information on server-to-server communication, go to the 
Novell Support Connection Web site (http://www.support.novell.com), 
and enter “625 errors” into the Quick Search field. Look for the 
Troubleshooting 625 Error Summary document.

� From the Windows 95/98 or Windows NT client, right-click the red 
Novell N and select NetWare Connections.

���������
�Novell Upgrade Wizard only supports the IPX protocol.

� Select the NDS tree that contains the destination server that you tried to 
migrate.


 Click Detach.

� Log in again to the NDS tree and the destination server that you are trying 
to upgrade.

� If you still have problems connecting to the target server, reboot the client 
workstation and then log in to the target server again.
�
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Restore the NetWare 4 Server to Its Original Configuration—
Multiserver Tree

The instructions for restoring the NetWare 4 server to its original 
configuration are different depending on when the migration of data failed.

If the migration failed before the NetWare 5.1 destination server could take 
over the name and identity of the NetWare 4 server, complete the steps in the 
following sections:

� “Remove NDS from the NetWare 4 Source Server—Multiserver Tree” on 
page 83.

� “Restore the NetWare 4 Source Server—Multiserver Tree” on page 85.

If the migration failed after the NetWare 5.1 destination server had taken on 
the name and identity of the NetWare 4 server, and the NetWare 4 server that 
you were migrating data from did not have a Master replica, complete the 
steps in the following sections:

� “Remove NDS from the NetWare 5.1 Destination Server—Multiserver 
Tree” on page 82.

� “Remove NDS from the NetWare 4 Source Server—Multiserver Tree” on 
page 83.

� “Restore the NetWare 4 Source Server—Multiserver Tree” on page 85.

� “Reinstall NetWare 5.1—Multiserver Tree” on page 86.

If the migration failed after the NetWare 5.1 destination server had taken on 
the name and identity of the NetWare 4 server, and the NetWare 4 server you 
were migrating data from did have a Master replica:

� Bring down the NetWare 5.1 destination server.

� Complete the steps in the following sections:

�� “Designate Another Server as the New Master Replica” on page 87.

�� “Remove NDS from the NetWare 4 Source Server—Multiserver 
Tree” on page 83.

�� “Restore the NetWare 4 Source Server—Multiserver Tree” on page 
85.

�	 “Prepare the NetWare 5.1 Destination Server” on page 75.
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Remove NDS from the NetWare 5.1 Destination Server—Multiserver Tree

To remove NDS from the NetWare 5.1 destination server:

� At the NetWare 5.1 server console, enter LOAD NWCONFIG.

� Select Directory Options > Remove Directory Services from This Server.

Ignore errors and confirm deletion of NDS (Directory Services).

� Select Yes to Remove Directory Services.

� Enter the Admin username and password.

� Press Enter to reference a different object.

�������
�Do not press Esc.

If you do press Esc, the references you entered will not be saved to the server.


 (Conditional) If prompted, enter the Admin username as the placeholder 
object distinguished name, then enter [Root] as the distinguished name to 
change from.

� If the information about single reference time source appears, review the 
information and press Enter.

To verify that NDS was removed:

� At the NetWare 5.1 server console, enter LOAD NWCONFIG.

� Select Directory Options > Remove Directory Services from This Server.

If a message indicates that Directory Services is already removed, continue 
with “Remove NDS from the NetWare 4 Source Server—Multiserver Tree” 
on page 83.

If NDS was not successfully removed, complete the following instructions to 
force NDS off the NetWare 5.1 server:

� At the NetWare 5.1 server console, enter LOAD NWCONFIG 
-DSREMOVE.

� Select Directory Options > Select Remove Directory Services from This 
Server.

The DSREMOVE option tells NWCONFIG to ignore all warning and error 
messages and remove Novell Directory Services®. The error and warning 
messages will still appear and may prompt for the Admin account and 
password. Just ignore or work through them. For example, if prompted for the 
Admin account and password, simply press Esc.
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NWCONFIG will still try to perform such steps as backing up trustee 
assignments, deleting server volume objects, clearing incoming connections, 
and changing necessary replica types, etc. But, if a step fails, NWCONFIG 
will probably report that the operation failed even though it has removed 
Directory Services.

Once NDS has been removed, you must manually remove the NetWare 5.1 
server from any replica rings that it was previously contained in and then 
delete the server and volume objects from the NDS tree.

To remove the server from the replica ring and the server and volume objects 
from the NDS tree:

� Bring down the server and turn it off.

� Use NDS Manager to delete the server object.

� Use NetWare Administrator to delete the volume objects.

� Once the server and volume objects have been deleted, go to the server 
console of the server containing the master replica of the replica ring and 
enter LOAD DSREPAIR -A.

� Select Advanced Options > Replica and Partition Operations.


 Select the replica ring where the downed NetWare 5.1 server was 
originally located.

� Select View the Replica Ring, then select the downed NetWare 5.1 server.

� Select Remove This Server from the Replica Ring.

� Enter your Admin distinguished name and password.

�� To confirm that you want to remove the server from the replica ring, enter 
“I agree” when prompted.

���������
�Make sure that you follow this procedure for each partition that the 
downed server held.

Continue with “Remove NDS from the NetWare 4 Source Server—
Multiserver Tree” on page 84.
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Remove NDS from the NetWare 4 Source Server—Multiserver Tree

To remove NDS from the NetWare 4 source server:

� At the NetWare 4 source server console, enter LOAD INSTALL.

� Select Directory Options > Remove Directory Services from This Server.

Ignore errors and confirm deletion of NDS (Directory Services).

� Select Yes to remove NDS (Directory Services).

If a message indicates that Directory Services is already removed, continue 
with “Restore the NetWare 4 Source Server—Multiserver Tree” on page 85.

If NDS was not properly removed, complete the following instructions to 
force NDS off the NetWare 4 server:

� At the NetWare 4 server console, enter LOAD INSTALL -DSREMOVE.

� Select Directory Options > Remove Directory Services from This Server.

The DSREMOVE option tells INSTALL to ignore all warning and error 
messages and remove Novell Directory Services. The error and warning 
messages will still appear and may prompt for the Admin account and 
password. Just ignore or work through them. For example, if prompted 
for the Admin account and password, simply press Esc.

INSTALL will still try to perform such steps as backing up trustee 
assignments, deleting server volume objects, clearing incoming 
connections, and changing necessary replica type, etc. But, if a step fails, 
INSTALL will probably report that the operation failed even though it has 
removed Directory Services.

Once NDS has been removed, you must manually remove the 
NetWare 5.1 server from any replica rings that it was previously 
contained in and then delete the server and volume objects from the NDS 
tree.

To remove the server from the replica ring and the server and volume objects 
from the NDS tree:

� Bring down the server and turn it off.

� Use the NDS ManagerTM utility to delete the Server object.

� Use NetWare Administrator to delete the Volume objects.
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� Once the server and volume objects have been deleted, go to the server 
console of the server containing the master replica of the replica ring and 
enter LOAD DSREPAIR -A.

� Select Advanced options menu > Replica and Partition Operations.


 Select the replica ring where the downed NetWare 4 server was originally 
located.

� Select View the replica ring, then select the downed NetWare 4 server.

� Select Remove This Server from the Replica Ring.

� Enter your Admin distinguished name and password.

�� To confirm that you want to remove the server from the replica ring, enter 
“I agree” when prompted.

���������
�Make sure that you follow this procedure for each partition that the 
downed server held.

Continue with “Restore the NetWare 4 Source Server—Multiserver Tree.”

Restore the NetWare 4 Source Server—Multiserver Tree

Once NDS was removed, you removed the server from any replica rings that 
held a partition of the NetWare 4 source server. You then removed the 
NetWare 4 source server’s corresponding server objects and volumes from the 
NDS tree. Next, complete the following steps to restore the NetWare 4 source 
server.

� Reboot the NetWare 4 source server.

� At the NetWare 4 source server console, enter LOAD INSTALL.

� Select Directory Services > Install Directory Services onto This Server.

� Select the NDS tree where the NetWare 4 source server existed prior to 
migration.

� Select a time zone and time configuration parameters.


 Enter the Admin name and password.

� Enter the context where the NetWare 4 source server existed prior to 
migration.

� Save the NDS (Directory) information and continue.

� Wait while the server synchronizes with the NDS tree.
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�� Select Restore Trustees from the Novell Upgrade Wizard Tools menu to 
restore the trustee assignments.

�� Use NDS Manager to check whether the NDS replicas that previously 
existed on the NetWare 4 source server still exist. If the NDS replicas do 
not exist, use NDS Manager to create them.

The NetWare 4 server is now restored to is original configuration.

Although you have restored the NetWare 4 server to its original configuration, 
you may need to complete more tasks depending on when the migration of 
data to the NetWare 5.1 destination server failed.

� If the migration failed before the NetWare 5.1 destination server took over 
the name and identity of the NetWare 4 server, you are ready to start the 
migration once again. Begin with Step 4 on page 76.

� If the migration failed after the NetWare 5.1 destination server had taken 
on the name and identity of the NetWare 4 source server and the 
NetWare 4 server did not have a master replica, continue with Reinstall 
NetWare 5.1—Multiserver Tree below.

� If the migration failed after the NetWare 5.1 destination server had taken 
over the name and identity of the NetWare 4 server and the NetWare 4 
source server did have a master replica, continue with “Prepare the 
NetWare 5.1 Destination Server” on page 75.

Reinstall NetWare 5.1—Multiserver Tree

To perform the upgrade again, you must reinstall NetWare 5.1.

To reinstall NetWare 5.1:

� Bring down the NetWare 5.1 destination server.

� Do a new installation of NetWare 5.1 by following the on-screen 
instructions.

After following the screen insructions, you can try the migration process 
again. Begin with Step 4 on page 76.
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Designate Another Server as the New Master Replica

If the server you tried to migrate held the Master replica, you will need to 
designate another server to be the Master replica before you can restore the 
NetWare 4 source server and NetWare 5.1 server to their original 
configurations.

� Locate another server in the replica ring.

� At the designated server console, enter LOAD DSREPAIR.

� Select Advanced Options > Replica and Partition Operations.

� Select the replica ring that the downed NetWare 5.1 server was located in.

� Select Designate This Server as the New Master Replica.

Continue with “Remove NDS from the NetWare 4 Source Server—
Multiserver Tree” on page 83.

Restore the NetWare 4 Server to Its Original Configuration—Single-
Server Tree

To restore the NetWare 4 source server, you must:

� Complete the steps in “Restore the NetWare 4 Source Server—Single-
Server Tree” on page 87.

� Complete the steps in “Reinstall NetWare 5.1—Single-Server Tree” on 
page 88.

For instructions on multiserver trees, see “Restore the NetWare 4 Server to Its 
Original Configuration—Multiserver Tree” on page 81.

Restore the NetWare 4 Source Server—Single-Server Tree

To restore the NetWare 4 source server to its original configuration:

� Enter RESTART SERVER at the NetWare 4 server console.

� After the server restarts, enter LOAD DSMAINT at the NetWare 4 server 
console.

� Select Restore NDS Following Hardware Upgrade.

� Press Enter to rename the NDS file and select Yes to confirm the chosen 
name.

NDS should now be successfully restored to the server.
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� Select Restore Trustees from the Novell Upgrade Wizard Tools menu to 
restore trustee assignments.


 Restart the server.

The NetWare 4 source server is now returned to its original configuration.

Reinstall NetWare 5.1—Single-Server Tree

To perform the upgrade again, you must reinstall NetWare 5.1.

To reinstall NetWare 5.1:

� Bring down the NetWare 5.1 destination server.

� Do a new installation of NetWare 5.1 by following the on-screen 
instructions.

After following the screen insructions, you can try the migration process 
again. Begin with Step 4 on page 76.
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� Install Novell Clients

This chapter explains how to install Novell® ClientTM for Windows* NT/2000 
and Novell Client for Windows 95/98 software, either from CD-ROM on one 
workstation or across the network. It describes how to:

� “Prepare to Install the Client Software” on page 90

� “Install Clients from CD-ROM” on page 94

� “Install Clients from the Network” on page 96

� “Upgrade a Client Workstation to Windows 2000” on page 102
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Prepare to Install the Client Software

Before installing the client software, make sure the server and workstations 
have sufficient resources and the required software. The hardware and 
software setup for the server and client workstations require you to complete 
the following tasks:

� Check server protocols and requirements

� Locate the latest Novell Client software

� Check for a valid network connection

� Check client workstation requirements

Check Server Protocols and Requirements

You must prepare your servers to work with the Novell Client software. You 
must know what protocols you use on the server and make sure that the servers 
are configured to support long filenames. NetWare® 5 automatically supports 
long filenames and does not need to have the namespace added to it. However, 
you must add long filename support to NetWare 3.x and NetWare 4.x servers.

You can install Novell Client with one of the following protocol options:

� IP Only (NetWare 5)

Installs the IP protocol stack, which allows the client to run in IP-only 
networks; the workstation cannot communicate with IPXTM servers.

� IP with IPX Compatibility Mode (NetWare 5)

Installs IP and includes Compatibility mode, which allows IPX 
applications to run in IP-only networks by converting IPX packets into IP 
packets. IPX Compatibility mode allows the client to communicate with 
services in IPX-only networks if the Migration Agent is installed on any 
NetWare 5 servers. IPX Compatibility mode requires Service Location 
Protocol (SLP) on the server.

� IP and IPX (default for new installations)

Allows the client to run in both IP and IPX networks. The workstation 
uses the same protocol as the server it is communicating with.

� IPX Only

Allows the client to run in IPX-only networks. This option does not install 
IP.
�
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���	
�If you are upgrading Novell Client software and you are keeping the same 
protocol option, you do not need to select a protocol option. The previous protocol 
configuration remains unchanged unless you choose a different protocol.

Add Long Namespace

Make sure that long filename support is installed on NetWare 3.x or 
NetWare 4.x servers. NetWare 5 servers automatically support long filenames.

���������
�Each namespace added to a volume requires additional server 
memory. If you add namespace support to a volume on a server without sufficient 
memory, that volume cannot be mounted. Once a namespace is added to a 
volume, the namespace can be removed from the volume only by deleting the 
volume and re-creating it, or by using VREPAIR.

� Load the long namespace.

At the server console prompt, enter

LOAD LONG.NAM

���	
�On versions of NetWare prior to NetWare 4.11, use the OS/2* namespace, 
OS2.NAM. For NetWare 3.11 servers, use OS2OPNFX.NML for long filenames. 
This NLMTM is a part of 311PTD.EXE and is available on the Novell Web site.

� Add the long namespace.

At the server console prompt, enter

ADD NAME SPACE LONG TO VOLUME volume_name

Locate the Latest Client Software

Novell Client software is shipped on CD-ROM and is also available from the 
Novell Web site. You should install the latest client version. If you purchased 
a Novell product, you can use the Novell Client included with that product.

� Create an installation directory.

� At www.novell.com/download, click the software that you want to 
download.

� Follow the download instructions provided with the files on the Web site.
Install Novell Clients ��

Installation Guide
100-004513-001 A
December 14, 1999
Novell Confidential



doc_tpl.fm Rev 99a 22 November 99
Prepare Client Workstations

Client Workstation Requirements

Client workstations must meet certain requirements before you install or 
upgrade Novell Client software:

� Workstation hardware and software

� The network board

Novell Client supports NDIS* drivers. For information about installing 
the network board, refer to the manufacturer’s instructions.

Platform Hardware Software

Windows 95/98 � 486 processor or 
better

� Minimum 28 MB 
free disk space

� Minimum 16 MB 
RAM

� Windows 95/98 
(Windows 95 
must be version 
A or later or you 
must use Service 
Pack 1 from 
Microsoft*)

� Windows 95 or 
Windows 98 
CD-ROM or the 
Windows .CAB 
files.

Windows NT/2000 � Minimum 
hardware 
requirements of 
Windows NT* 4.0

� Minimum 
hardware 
requirements of 
Windows 2000

� Minimum 24 MB 
RAM

� Windows NT 4.0 
or Windows 2000 
(Windows NT 
must have 
Service Pack 3 or 
later)
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���������
�By default, ODITM drivers are not installed. If you are upgrading an 
older version of the client and you have ODI drivers currently installed, these 
drivers are still supported. If you are installing for the first time, NDIS drivers will be 
installed. If you do not already have the necessary NDIS driver, you might need to 
obtain it from the operating system CD-ROM or from the network board 
manufacturer.

Incompatibilities

Windows 95/98

The following network components are not compatible with Novell Client for 
Windows 95/98:

� Microsoft Client for NetWare networks

� Microsoft file and printer sharing for NetWare networks

� Microsoft Service for NDS® software

� Novell NetWare workstation shell 3.x (NETX)

� Novell NetWare workstation shell 4.0 and later (VLMTM) clients

� Novell IPX ODI protocol 16-bit module for the NETX and VLM clients

If any of these network components are installed, the client installation 
program detects the conflict and removes the conflicting network 
components.

Windows NT/2000

For up-to-date information about software incompatibilities, see the Novell 
Client for Windows NT/2000 readme file, WINNT.TXT.

Additional Information

“Install Clients from CD-ROM” on page 94

“Install Clients from the Network” on page 96
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Install Clients from CD-ROM

If you plan to install Novell Client software on a small number of 
workstations, or if the workstations are not yet connected to a network, install 
from the Novell Client CD.

���	
�If installing or upgrading Novell Client software on several workstations on 
the network, consider using the network installation explained in “Install Clients 
from the Network” on page 96.

You can install the Novell Client using the Application Launcher component of 
ZENworksTM. Application Launcher lets you distribute applications such as the 
client software to workstations and manage those applications as objects in the 
NDS tree. For more information, see the ZENworks documentation.

The Novell Client Setup utility installs Novell Client software on workstations 
running Windows. This utility lets you select the client that you want to install 
from a list of available clients. Administrative options are also available.

To install from a local CD-ROM drive:

� Insert the Novell Client CD.

If the Novell Client Setup utility does not automatically launch, run 
WINSETUP.EXE from the root of the CD.

� Click a language.

� Click a platform.

� Click the software to install.

This starts the installation utility for that software. 

� Follow the on-screen instructions.

Once Novell Client is installed, check your network protocol configuration. 
See “Configure Network Protocols” on page 95.
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Configure Network Protocols

After you install Novell Client, make sure that it is configured correctly for 
your network.

�������
�Before you configure network protocols, make sure that you have the 
correct information and any addresses needed. If you configure protocols 
incorrectly, the workstation will not be able to connect to the network, or it may 
conflict with other workstations using the same address.

� Right-click Network Neighborhood, then select the protocol that you 
want to configure and click Properties.

� Configure the protocol options in each tab, then click OK.

For example, if your network uses DHCP to assign IP addresses 
automatically, click the IP Address tab, then click Obtain IP Address 
Dynamically. Or, if you must use a static IP address, click Specify an 
Address and enter the specific address given to you by your network 
administrator.

����
  Click the question mark in the upper-right corner, then click on any field for 
more information. 

� Click OK to make the changes.

���	
�You might be asked to supply the Windows operating system CD. If you do 
not have access to the correct files, you may not be able to create a network 
connection.

You should now set the Novell Client properties for the workstation. See 
Chapter 3, “Setting Client Properties,” in the Novell Client Online 
Documentation.
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Install Clients from the Network

You can install Novell Client software on multiple workstations from the 
network by copying files to the server and modifying the login script. This 
installation is sometimes referred to as an Automatic Client Upgrade (ACU).

You can install and upgrade the client software on all platforms when users log 
in. The process involves six tasks:

� Create a folder on the server.

� Copy Novell Client files and other required files to this folder. 
Workstations can then read the files during login.

� Grant rights to the new folder.

� Modify the ACU configuration file.

� (Optional) Create or update the platform-specific configuration files.

� Create or modify the login script. (A sample login script is included.)

When the login script runs, ACU.EXE determines if the client needs to be 
upgraded. This initial check saves network bandwidth during login since the 
setup utility is only run if the client needs to be updated.

Create a Folder

� Log in to a server as Admin or as a user with Admin equivalence.

Make sure that you have rights to copy files to a network folder that all 
users can access, as well as rights to modify login scripts.

� Create a folder in SYS:PUBLIC.

For example,

SYS:\PUBLIC\CLIENT

Copy Files

� From the PRODUCTS directory on the Novell Client CD, copy the 
WINNT or WIN95 directories to the new folder.

If you are installing only one platform, you need to copy only the platform 
directory (WINNT or WIN95) for the platform you will install.
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If you are installing the client in only one language or if your network 
does not have enough space to accommodate multiple language 
directories, you can delete the language directories that you do not need 
from the NLS directory under each client directory. To ensure that you 
have all necessary files, copy the entire client directory and then delete 
only the extra language directories.

� (Conditional) If you are installing Novell Client for Windows 95/98, copy 
the Windows 95 and/or Windows 98 .CAB files to the WIN95 directory.

The files are on the Microsoft Windows 95 or Windows 98 CD (and 
Upgrade CD) in the respective WIN95 or WIN98 folder.

Grant Rights

� Create a Group object in the NDS tree.

� Place into that group users whose workstations need to be installed or 
upgraded.

� Make sure that the group has Read and File Scan rights to the folder that 
you created.

���	
�If you created a folder in SYS:PUBLIC, the new folder should have Read 
and File Scan rights already associated with it, but you should make sure that 
these rights have not been changed.

� (Conditional) If you want the results of the installation to be added to a 
status log file, make sure that the group has Write rights to that file.

A status log file records the success or failure of the installation. As each 
workstation completes its installation, the status log file is appended to 
include information on that workstation. Enable status logging in the 
ACU configuration file.

���	
�If you did not create the status log file prior to running the network 
installation, you must give users Create and Write rights to the directory.
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Modify the ACU Configuration File

The Automatic Client Upgrade utility (ACU.EXE) determines if the client 
needs to be updated and allows you to determine several install options.

To customize ACU:

� Open the ACU.INI file located in the folder that you created on the server.

� Modify the configuration options.

���������
�We recommend that you use the ACU.INI file instead of the 
command line switches used in previous versions. ACU.INI has been created to 
simplify the installation process. If you choose to use switches, they will override 
ACU.INI options.

Option Description Settings

[UNATTENDFILE] Determines if a platform-specific 
configuration will be used and 
where it is located.

Use=Yes | No (default: No)

File=configuration file path

[STATUSLOGGING] Determines if a status log will be 
created and where it will be located.

If you did not create a status log file 
prior to installation, it will be created 
and placed in the installation 
directory on the network or in the 
directory specified in the File 
setting.

Use=Yes | No (default: No)

File=log file path

[LAUNCHINSTALL] Determines if the platform-specific 
setup utility will be launched once 
ACU.EXE determines that the 
install is necessary.

Launch=Yes | No (default: 
Yes)

[DISPLAYDIALOG] Determines if users will be 
prompted to begin the upgrade.

Display=Yes | No (default: 
Yes)
�� Installation Guide

Installation Guide
100-004513-001 A
December 14, 1999
Novell Confidential



doc_tpl.fm Rev 99a 22 November 99
Update the Platform-Specific Configuration Files

���	
�If you are installing the client with the default settings, you do not need to 
create or modify the configuration files. Skip this process and proceed to “Create 
or Modify the Login Script” on page 100.

���������
�If you use a platform-specific configuration file to configure Novell 
Client, you must change the [UNATTENDFILE] option to Yes.

Each platform-specific installation utility reads a configuration file generated 
by Novell Client Install Manager in order to configure the client properties. 
This file provides information such as where to copy drivers during 
installation and the most recent version number. This file must be placed in the 
same folder as the installation utility.

���������
�If you are configuring Windows 95/98 workstations, options that 
were set in the NWSETUP.INI file or on the command line in previous versions of 
Novell Client (such as Display First Screen or CAB FIX) are now set up in Novell 
Client Install Manager.

To create a configuration file:

� Start Novell Client Install Manager (NCIMAN.EXE).

For Windows 95/98, Novell Client Install Manager is located in the 
WIN95\IBM_language \ADMIN folder that you copied to the server.

For Windows NT/2000, Novell Client Install Manager is located in the 
WINNT\I386\ADMIN folder that you copied to the server.

� Select File > New, then select the platform and click OK.

� Modify the installation options as needed.

�� In the Installation Options list box, double-click the configuration 
option that you want to modify.

�� In the property pages, set the parameters and then click OK.

The values that you set appear in the right list box.

����
 You can import the settings from a workstation that has been previously 
configured and save them to the configuration file. Once you set up the 
workstation, select File > Import Registry to import the settings.

� Select File > Save.

You can use any filename—for example, UNATT_95.TXT or 
UNATT_NT.TXT.
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� Copy this file to one of the following directories:

� WIN95\IBM_language (for Windows 95/98)

� WINNT\I386 (for Windows NT/2000)

���������
�The path to the text file cannot contain long filenames.

Create or Modify the Login Script

You need to modify login scripts for users whose workstations will be 
upgraded.

� To upgrade workstations for users in a container, modify that container’s 
login script.

� To upgrade workstations for users in a profile, modify that profile’s login 
script.

� To upgrade specific users’ workstations, modify those users’ login 
scripts.

� To upgrade a workstation running bindery-based client software (such as 
Microsoft Client for NetWare Networks that ships with Windows 95 or 
Windows 98), edit the system login script 
(SYS:PUBLIC\NET$LOG.DAT).

Create or Modify a Login Script Using NetWare Administrator

To create or modify a login script using NetWare Administrator:

� Start NetWare Administrator.

� Using the browser, select the object whose login script you want to create 
or modify.

� Select Object > Details > Login Script.

� Enter the login script commands and information into the login script text 
box.

For a sample of the login script commands that you need to add to the 
scripts, see “Sample Client Installation Login Script” on page 101.

���������
�Make sure that you edit the sample login script to match the server 
names, directory paths, and specifications of your own network.

For additional information on all login script commands, see Appendix A, 
“Login Script Commands and Variables,” in the Novell Client Online 
Documentation.
�

 Installation Guide

Installation Guide
100-004513-001 A
December 14, 1999
Novell Confidential



doc_tpl.fm Rev 99a 22 November 99
� To save the login script and close the Details dialog box, click OK.

If the login script that you just created was a container or user login script, 
you’re finished and the client software will be installed or updated the 
next time users log in.

If the login script that you just created was for a Profile object, you must 
associate the User object with the Profile and make the User object a 
trustee of the Profile object. For additional information on all login 
scripts, see “Creating or Modifying Login Scripts” in Chapter 2 of the 
Novell Online Client Documentation.

Sample Client Installation Login Script

The following sample shows the commands that you add to the login script to 
install the client software from the network. The sample includes sample text 
for installing across an internal network.

���������
�In this sample, the information that is necessary to the script is 
represented in uppercase letters. The information that you should customize for 
your network is in lowercase letters.

���	
�If you are using this sample script to replace the Microsoft Client with Novell 
Client for Windows95/98, some user intervention is necessary. Due to the limited 
scripting capabilities of the Microsoft Client, users must close an open DOS box 
before the workstation is rebooted and the installation is completed.

REM *****  Windows 95/98 *****
If PLATFORM = "W95" or PLATFORM = "W98" THEN
   WRITE "Updating Novell Client for Windows 95/98."
   #\\server1\sys\public\client\win95\ibm_enu\acu.exe
   IF "%ERROR_LEVEL" = "1" THEN
        EXIT
   END
REM *****  Windows NT/2000 *****
IF PLATFORM = "WNT" THEN
   WRITE "Updating Novell Client for Windows NT/2000."
   #\\server1\sys\public\client\winnt\i386\acu.exe
   IF "%ERROR_LEVEL" = "1" THEN
        EXIT
   END

What Users See

If this is a new client software installation, or if it is an upgrade from older 
client software, the software is installed or upgraded when users log in and 
restart the workstation. Users might see system messages as their workstations 
are upgraded, depending on how you set up the installation.
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Upgrade a Client Workstation to Windows 2000

You can upgrade a Windows 95/98 or Windows NT 4.0 workstation with 
Novell Client software to Windows 2000 without uninstalling the client 
software.

Windows 95/98 to Windows 2000—Installs Novell Client version 4.51 from 
the Windows 2000 CD.

Windows NT to Windows 2000—Detects the version of Novell Client 
software installed and does one of the following:

� If the Novell Client version is 4.6 or earlier, Windows 2000 installs the 
Novell Client version 4.51 from the Windows 2000 CD.

� If the Novell Client version is 4.7 or later, Windows 2000 leaves it in tact 
but removes all installed components and changes the protocol selection.

After the migration to Windows 2000 is complete, Novell Client will reinstall 
the previously installed components and restore the previously selected 
protocols.

�������
�In order to complete the reinstallation of the components and 
protocols, the user who logs in to the workstation after the migration must have 
Administrator rights.

Novell Client version 4.51 on the Windows 2000 CD has limited functionality. 
Therefore, you will want to upgrade to the latest Novell Client version once 
you have completed the upgrade. To facilitate this, Novell Client will run an 
Automatic Client Upgrade from one of the following places:

� The path pointed to by the NWCLIENTDIR environment variable in the 
login script or at the command line

� The path where Novell Client was installed from

� Drive Z: on the network

You may choose to skip the Automatic Client Upgrade by setting the 
NWCLIENTDIR environment variable to NULL in the login script.

For more information on Automatic Client Upgrade, see “Install Clients from 
the Network” on page 96.

For more information on installing Novell Client on individual workstations, 
see “Install Clients from CD-ROM” on page 94.
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� Install Networking Products

This chapter describes the networking products that are available with 
NetWare 5.1®, and how to install and use them.

���	
�For additional information about setting up, configuring, or using these 
products and services, see the NetWare 5.1 documentation, located on the Novell 
Documentation CD or at at http://www.novell.com/documentation.

New Products and Services

� NetWare Enterprise Web Server

� NetWare News Server

� NetWare Web Manager

� NetWare Web Search Server

� NetWare MultiMedia Server

� IBM* WebSphere* Application Server

Traditional Products and Services

� Novell® Distributed Print ServicesTM

� LDAP for NDS®

� NetWare FTP Server

� Novell DNS/DHCP Services

� Catalog Services

� WAN Traffic Manager Services
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Network Administration Tools

� ConsoleOneTM

� NetWare Administrator

� NetWare Management PortalTM

� NDS ManagerTM

� Novell Licensing Services

New Products and Services

NetWare 5.1 includes several new products and services that provide 
functionality that has traditionally been associated only with the Internet. 
These NetWare products will add tremendous value to your company’s 
network, your Internet Web site, or both.

NetWare Enterprise Web Server

NetWare Enterprise Web Server allows you to add Web-server functionality to 
your NetWare server. NetWare Enterprise Web Server allows your NetWare 
server to use the HTTP protocol to store Web information and provide Web 
pages to clients, such as Web browsers.

You can use NetWare Enterprise Web Server to create Web sites that are 
available to the entire Internet or only to users on your network.

To install NetWare Enterprise Web Server during the NetWare 5.1 server 
installation:

� From the Installation Options screen, select Custom.

� From the Components screen, check the check box for NetWare 
Enterprise Web Server.

� Follow the on-screen instructions.

To install NetWare Enterprise Web Server software after the NetWare 5.1 
server installation:

� At the NetWare server console, access the servertop by entering STARTX.

� Click Novell > Install > Add.

� Specify the path to the NetWare Enterprise Web Server files. (NetWare 
Enterprise Web Server files are located on the NetWare 5.1 Operating 
System CD in the PRODUCTS\NOVONYX directory.)
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���	
�To access the CD, you may need to enter CDROM at the server console.

� Follow the on-screen instructions to complete the installation.

To configure NetWare Enterprise Web server, use NetWare Web Manager.

NetWare News Server

NetWare News Server allows you to provide newsgroup and discussion group 
functionality on your NetWare network. You can provide discussion groups 
for all of your users on the Internet, on your internal network, or both. 
Newsgroups are accessed and read using a standard Web browser, such as 
Netscape* Navigator* or Internet Explorer.

To install NetWare News Server during the NetWare 5.1 server installation:

� From the Installation Options screen, select Custom.

� From the Components screen, check the check box for NetWare News 
Server.

� Follow the on-screen instructions.

To install NetWare News Server after the NetWare 5.1 server installation:

� At the NetWare server console, access the servertop by entering STARTX.

� Click Novell > Install > Add.

� Specify the path to the NetWare News Server files. (NetWare News 
Server files are located on the NetWare 5.1 Operating System CD in the 
PRODUCTS\NOVONYX directory.)

���	
�To access the CD, you may need to enter CDROM at the server console.

� Follow the on-screen instructions to complete the installation.

To set up and configure NetWare News Server, use NetWare Web Manager.

NetWare Web Manager

NetWare Web Manager allows you to use a Web browser to manage Web 
browser-based services available with NetWare 5.1, such as NetWare News 
Server, NetWare Enterprise Web Server, and NetWare MultiMedia Server.

To install NetWare Web Manager during the NetWare 5.1 server installation:

� From the Installation Options screen, select Custom.

� From the Components screen, check the check box for NetWare Web 
Manager.
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� Follow the on-screen instructions.

���������
�Record the port number for NetWare Web Manager.

To install the NetWare Web Manager software after the NetWare 5.1 server 
installation:

� At the NetWare server console, access the servertop by entering STARTX.

� Click Novell > Install > Add.

� Specify the path to the NetWare News Server files. (NetWare News 
Server files are located on the NetWare 5.1 Operating System CD in the 
PRODUCTS\NOVONYX directory.)

���	
�To access the CD, you may need to enter CDROM at the server console.

� Follow the on-screen instructions to complete the installation.

���������
�Record the port number for NetWare Web Manager.

To access NetWare Web Manager:

� Launch a Web browser from a Windows* workstation. 

� Enter the following information in the Location or URL field:

https://<server IP address>:<NetWare Web Manager port 
number>

���	
�You do not need the “s” on the end of http if you don’t require secure data 
transmission.

NetWare Web Search

NetWare Web Search helps you create indexes for adding search capability to 
your Internet or intranet Web sites. NetWare Web Search can index files and 
documents located on NetWare servers and other Web servers.

To install NetWare Web Search during the NetWare 5.1 server installation:

� From the Installation Options screen, select Custom.

� From the Components screen, check the check box for NetWare Web 
Search.

� Follow the on-screen instructions.

To install NetWare Web Search after the NetWare 5.1 server installation:

� At the NetWare server console, access the servertop by entering STARTX.

� Click Novell > Install > Add.
�
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� Specify the path to the NetWare Web Search files. (NetWare Web Search 
files are located on the NetWare 5.1 Operating System CD in the 
PRODUCTS\NSEARCH directory.)

���	
�To access the CD, you may need to enter CDROM at the server console.

� Follow the on-screen instructions to complete the installation.

To make sure that NetWare Web Search is available:

� Launch a Web browser from a Windows workstation.

� Enter the following information in the Location or URL field:

http://<server IP address>/NOVELLSEARCH

� When the default search form appears, enter a word or phrase.

� Click Search.

To set up and configure NetWare Web Search, use NetWare Web Manager.

NetWare MultiMedia Server

NetWare MultiMedia Server adds functionality to your NetWare 5.1 server, 
enabling it to store and deliver streaming multimedia files to anyone accessing 
the data with a Web browser.

To install NetWare MultiMedia Server during the NetWare 5.1 server 
installation:

� From the Installation Options screen, select Custom.

� From the Components screen, check the check box for NetWare 
MultiMedia Server.

� Follow the on-screen instructions.

To install NetWare MultiMedia Server after the NetWare 5.1 server 
installation:

� At the NetWare server console, access the servertop by entering STARTX.

� Click Novell > Install > Add.

� Specify the path to the NetWare MultiMedia files. (NetWare Web Search 
files are located on the NetWare 5.1 Operating System CD in the 
PRODUCTS\MMSERVER directory.)

���	
�To access the CD, you may need to enter CDROM at the server console.

� Follow the on-screen instructions to complete the installation.
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To set up and configure NetWare MultiMedia Server, use NetWare Web 
Manager.

IBM WebSphere Application Server

IBM WebSphere for NetWare provides an environment to deploy and manage 
Java* applications on a NetWare server. You can use WebSphere to build, run, 
and manage e-commerce applications on your NetWare 5.1 server.

To set up IBM WebSphere Application Server during the NetWare 5.1 server 
installation.

� From the Installation Options screen, select Custom.

� From the Components screen, check the check box for NetWare 
MultiMedia Server.

� Check the check box for IBM WebSphere Application Server.

� Complete the NetWare 5.1 server installation by following the on-screen 
instructions.

� (Optional) Install Oracle8*. You must have the Oracle* database installed 
to run the sample applications. (The Oracle8 installation files are located 
on the Oracle CD.)

To install IBM WebSphere Application Server after the NetWare 5.1 server 
installation.

� At the NetWare server console, access the servertop by entering STARTX.

� Click Novell > Install > Add.

� Specify the path to the IBM Websphere Application Server files. (IBM 
Websphere Application Server files are located on the NetWare 5.1 
Operating System CD in the PRODUCTS\WAS directory.)

���	
�To access the CD, you may need to enter CDROM at the server console.

� Follow the on-screen instructions to complete the installation.

� (Optional) Install Oracle8. You must have the Oracle database installed in 
order to run the sample applications. (The Oracle8 installation files are 
located on the Oracle CD.)

For more information, see the IBM WebSphere for NetWare Web site (http://
developer.novell.com/ndk/ibmws.htm).
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Traditional Products and Services

NetWare 5.1 includes many products and services that add value to your 
network. This section provides descriptions and instructions for setting up a 
few of the key traditional products that are available with NetWare 5.1.

Novell Distributed Print Services

Novell Distributed Print Services (NDPS®) helps you set up and manage 
printers.

To install NDPS during the NetWare 5.1 server installation:

� From the Installation Options screen, select Custom.

� From the Components screen, check the check box for Novell Distributed 
Print Services.

� Complete the NetWare 5.1 server installation by following the on-screen 
instructions.

To install NDPS after the NetWare 5.1 server installation:

� At the NetWare server console, access the servertop by entering STARTX.

� Click Novell > Install > Add.

� Specify the path to the NDPS files. (NDPS is located on the NetWare 5.1 
Operating System CD in the PRODUCTS\NDPS directory.)

� Follow the on-screen instructions to complete the NDPS installation.

To set up and configure NDPS:

� From a Windows 95/98 or Windows NT* workstation, log in to the 
network.

� Run NetWare Administrator. (NWADMN32.EXE is located in the 
SYS:PUBLIC\WIN32 directory.)

� Create an NDPS Manager.

� Create an NDPS printer.

� (Conditional) If legacy clients still require print queues, configure the 
NDPS printer to service jobs submitted to traditional print queues.
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LDAP Services for NDS

LDAP Services for NDS allows clients to use the LDAP (Lightweight 
Directory Access Protocol) protocol to access information stored in NDS.

For example, you could use LDAP Services for NDS to provide external 
customers with a directory of your employees. Using a Web browser, the 
external customers could browse through whatever information you allow 
them to access.

After installing the NetWare 5.1 server, verify that [Public] has rights to 
receive LDAP Directory or NDS information. 

To verify or grant rights to [Public]:

� From a Windows 95/98 or Windows NT workstation, log in to the 
network.

� Run NetWare Administrator. (NWADMN32.EXE is located in the 
SYS:PUBLIC\WIN32 directory.)

� From NetWare Administrator, right-click on the highest container object 
that the LDAP client will be allowed to access with a browser. For 
example, to grant access to the entire tree, right-click on the [Root] object 
of the tree.

� Select Trustees of this Object.

� Add [Public] as a new trustee.


 In Object Rights, check Browse.

� In Property Rights, select All Properties, then check Compare and Read.

For more information, see the LDAP Services for NDS Web site (http://
www.novell.com/products/nds/ldap.html).
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NetWare FTP Server

NetWare FTP Server provides File Transfer Protocol (FTP) service for 
transferring files between any FTP clients. Adding FTP functionality to your 
NetWare server will allow you log in to the NDS tree using any FTP client. 
After logging in to the NDS tree, you can navigate to other NetWare servers

To install NetWare FTP Server during the server installation:

� From the Installation Options screen, select Custom.

� From the Components screen, check the check box for NetWare FTP 
Server.

� Follow the on-screen instructions to complete the NetWare 5.1 server 
installation.

To install NetWare FTP Server after the NetWare 5.1 server installation:

� At the NetWare server console, access the servertop by entering STARTX.

� Click Novell > Install > Add.

� Specify the path to the FTP Server files. (FTP Server files are located on 
the NetWare 5.1 Operating System CD in the PRODUCTS\FTP 
directory.)

���	
�To access the CD, you may need to enter CDROM at the server console.

� Follow the on-screen instructions to complete the installation.

Novell DNS/DHCP Services

Novell DNS/DHCP Services integrates the Domain Name System (DNS) and 
Dynamic Host Configuration Protocol (DHCP) into the NDS database. 
Integrating these services into NDS provides centralized administration and 
enterprise-wide management of network (IP) addresses, configurations, and 
hostnames.

Integrating DNS with NDS greatly simplifies the task of network 
administration by enabling you to enter all configuration information into one 
distributed database. The DNS configuration information is replicated just 
like any other data in NDS.

A NetWare DHCP server automatically assigns IP addresses and other 
configuration information to clients upon request or when the clients are 
restarted. Automatic assignment of configuration information reduces the 
amount of work required to configure and manage a large IP network.
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To add Novell DNS/DHCP Services during the NetWare 5.1 server 
installation:

� From the Installation Options screen, select Custom.

� From the Components screen, check the check box for Novell DNS/
DHCP Services.

� Complete the NetWare 5.1 server installation following the on-screen 
instructions.

To add Novell DNS/DHCP Services after the NetWare 5.1 server installation:

� At the NetWare server console, access the servertop by entering STARTX.

� Click Novell > Install > Add.

� Specify the path to the Novell DNS/DHCP Services files. (Novell DNS/
DHCP Services files are located on the NetWare 5.1 Operating System 
CD in the PRODUCTS\DNIP directory.)

���	
�To access the CD, you may need to enter CDROM at the server console.

� Follow the on-screen instructions to complete the installation.

To set up and configure Novell DNS/DHCP Services:

� From a Windows 95/98 or Windows NT workstation, log in to the 
network.

� Run SYS:PUBLIC\DNSDHCP\SETUP.EXE to install the DNS/DHCP 
Management Console.

� (Conditional) Use DNS/DHCP Management Console to import DHCP 
information.

� Set up DHCP.

�� From DNS/DHCP Management Console, select DHCP Service.

�� Click the Global Preferences icon.

�� Click Global DHCP Options > Modify.

�	 Select the desired options and provide the required information.

�
 Enter or browse for the desired server and click Create > Subnet > 
OK.

�� Select the Subnet to create Subnet Address Range objects under, then 
click Create.
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�� Select the Subnet to create IP Address objects under, then click 
Create.

�� Enter the IP Address to be assigned or excluded, then select 
Assignment Type > Create.

� Load DHCP by entering DHCPSRVER at the NetWare server console.


 Load DNS by entering NAMED at the NetWare server console.

Catalog Services

Catalog Services, an option available only for NDS 7, lets administrators and 
applications create catalogs of frequently accessed NDS objects. Catalog 
Services is designed to provide faster access to information in the NDS 
database and provide enhanced search capabilities.

���	
�The functionality of Catalog Services is integrated with NDS 8. If you are 
installing NDS 8, the option to install Catalog Services will be unavailable.

A catalog is an NDS object that stores information from the NDS database. 
The catalog stores only objects and properties that you specify, and lets you 
find information about those objects without a time-consuming search of the 
entire NDS tree.

A catalog can contain information from an entire NDS tree or from a portion 
of the tree. For example, you can create a catalog of all users with their 
complete names and their telephone numbers. The catalog is stored as an NDS 
object and provides rapid access to selected NDS data. Catalog objects are 
created, used, and managed using NetWare Administrator. You can update a 
catalog as needed or schedule periodic, automatic updates.

To install Catalog Services during the NetWare 5.1 server installation:

� From the Installation Options screen, select Custom.

� From the Components screen, check the check box for Catalog Services.

� Complete the NetWare 5.1 server installation by following the on-screen 
instructions.

To install Catalog Services software after the NetWare 5.1 server installation:

� At the NetWare server console, access the servertop by entering STARTX.

� Click Novell > Install > Add.
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� Specify the path to the Catalog Services installation files. (Catalog 
Services files are located on the NetWare 5.1 Operating System CD in the 
PRODUCTS\CATALOG directory.)

���	
�To access the CD, you may need to enter CDROM at the server console.

� Follow the on-screen instructions to complete the installation.

To set up Catalog Services:

� Make sure that your NetWare 5.1 server is running NDS version 7.

���	
�To check the NDS version, enter VERSION at the server console.

� Load the Catalog Services NLMTM (the dredger) by entering dscat at 
the NetWare server console.

WAN Traffic Manager Services

WAN Traffic Manager controls the communication of select NDS events 
between NetWare servers. It lets you define when you want to synchronize 
NDS replica data between servers, thus reducing unnecessary traffic across 
your WAN links.

You could use WAN Traffic Manager to schedule synchronization of the NDS 
replica at a remote site. By scheduling when synchronization occurs, you can 
synchronize your NDS replica data when network bandwidth is available and 
communication costs are low.

To set up WAN Traffic Manager:

� During the NetWare 5.1 server installation, check the check box for WAN 
Traffic Manager.

� After the installation is complete, you need to load the WAN Traffic 
Manager NLM by entering wtm on each participating NetWare server.

� Use NetWare Administrator or ConsoleOne to configure WAN Traffic 
Manager.
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Network Administration Tools

NetWare 5.1 provides you with a variety of tools for managing your network. 
This section describes some of the tools that are available and how to use 
them.

ConsoleOne

ConsoleOne runs either on a Windows workstation or on the server console, 
and lets you view and manage your NDS network resources. You can use 
ConsoleOne to create and manage NDS objects for users, groups, servers, 
files, and directories.

After you install NetWare 5.1, you can use ConsoleOne to create users. In 
addition to managing NDS objects, you can use ConsoleOne from your 
Windows workstation to establish a remote console session with a NetWare 
server.

To run ConsoleOne on a Windows 95/98 or Windows NT workstation:

� Make sure that your workstation is running the Novell ClientTM software 
available with NetWare 5.1.

� At the workstation, map a network drive to 
SYS:PUBLIC\MGMT\CONSOLEONE\BIN on a NetWare 5.1 server.

� Run CONSOLEONE.EXE.

To run ConsoleOne on a NetWare server, do one of the following:

� If the servertop (GUI interface) is running on the server, click Novell > 
Programs > ConsoleOne.

� If the servertop is not running, enter C1START at the server console.
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NetWare Administrator

NetWare Administrator is used to create and manage NDS objects on your 
network. Use NetWare Administrator to create users and home directories for 
each user.

To run NetWare Administrator:

� From a Windows 95/98 or Windows NT workstation, log in to the 
network.

� Map a drive to SYS:PUBLIC\WIN32 on a NetWare 5.1 server.

� Run NWADMN32.EXE.

NetWare Management Portal

NetWare Management Portal enables you to use a Web browser to manage 
NetWare servers from a Windows workstation.

You can use NetWare Management Portal for typical server management tasks 
such as mounting and dismounting volumes, managing server connections, 
and configuring SET parameters. You can also check the general health status 
of servers, access files on volumes and DOS partitions, and monitor the health 
of many server processes and resources.

To access NetWare Management Portal:

� Launch a Web browser from a Windows workstation. 

� Enter the following information in the Location or URL field:

http://<NetWare server IP address>:8008

���	
�If NetWare Enterprise Web Server is not installed on your NetWare server, 
you do not need to add the port number (8008) after the IP address.

� Click Login. Log in as Admin or an administrator equivalent to gain 
access to all the features and functions.
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NDS Manager

NDS Manager allows you to create and manage NDS partitions and replicas 
from a Windows 95/98 or Windows NT workstation.

If your network is not centrally located, you could use NDS Manager to create 
a replica of the NDS information relating to each remote site. Because users 
access their own local NDS replica, they do not access the NDS information 
at the central location. Network users get faster network performance by 
accessing their own local NDS replica.

To run NDS Manager:

� From a Windows 95/98 or Windows NT workstation, log in to the 
network.

� Map a drive to SYS:PUBLIC\WIN32 on a NetWare 5.1 server.

� Run NDSMGR32.EXE.

For more information on NDS Manager, see the NDS Manager online help.

Novell Licensing Services

Novell Licensing Services (NLS) keeps track of how many valid licenses are 
available for specific software programs on your network. You can find out 
whether your company needs to buy more software licenses, or whether your 
company requires fewer software licenses.

Novell Licensing Services, combined with ZENworksTM, enables you to use 
software metering to monitor the usage of specific software programs or files 
on your network—even if the program is not NLS-enabled. Using NLS, you 
can uncover how many times a specific file has been opened in the past week 
or how many users are currently using it.

To view license information on your network:

� From a Windows 95/98 or Windows NT workstation, log in to the 
network.

� Map a drive to SYS:PUBLIC\WIN32 on a NetWare 5.1 server.

� Run NWADMN32.EXE.

� Double-click a specific License Certificate object.

� (Optional) Select Tools > Novell Licensing Services > Generate Reports 
to view all License Certificate objects on your network.
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Summary

For complete information on these products and services—and the many more 
products and services that are available with NetWare 5.1—see:

� The NetWare 5.1 Online Documentation CD included with the 
NetWare 5.1 product.

� The Novell Product Documentation Web site (http://www.novell.com/
documentation).

� The NetWare Deployment Web site (http://www.novell.com/
deployment).
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Index
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ACU (Automatic Client Upgrade), configuration file, 
modifying 98

AUTOEXEC.BAT file, commands for installation 
files 18, 61

AUTOEXEC.NCF file
commands for loading server operating system 

21, 41
source server address, containing 75

Automatic reboot, setting 21

�

Backup, creating before upgrade 61
Block size, editing for volume SYS 31
Boot partition. See DOS partition

�

Catalog Services, installing 113
CD

drive requirements 14, 58
using to install new server 18
using to upgrade server 61

CDM (custom device module) 27
Certificate Authority object, creating 51
Certificate Server, Novell, installing 51
Client workstations, preparing

hardware and software requirements 92
incompatibilities 93
network board 92

Code page, selecting 22
Compatibility Mode, IPX. See IPX Compatibility 

Mode
Computer, preparing for server install 17
CONFIG.SYS file

commands for installation files 18, 61
commands for loading server operating system 

21

ConsoleOne, running 115
Country code, selecting 22
Custom device module 27
Custom installation, choosing for install 53

�

Data migration, editing for volume SYS 31
Deployment Manager. See NetWare Deployment 

Manager
Destination server

migrating objects and volumes to NDS tree 68
preparing for Novell Upgrade Wizard 67, 75
unable to reconnect to, troubleshooting 80

Device drivers, changing SET parameters for 
install 21

DNS (Domain Name Service), setting up during 
install 42

DNS server, configuring 42
DNS/DHCP Services, Novell, installing 111
DOS partition

creating 17
verifying before upgrade 61

Driver, adding, deleting, or modifying 24, 26

�

File compression, editing for volume SYS 31
File system

creating backup before upgrade 61
NetWare, installing 34

Files, copying for Novell Client install 96
Filtered environment, installing from 21
Folder, for Novell Client install

creating 96
granting rights to 97

Frame types, IPX 41
FTP Server, NetWare, installing 111
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�

Gateway address, specifying for install 40
GUI interface, keyboard commands for install 

program 32

�

Hardware, preparing for server install 17
Hot Fix, turning off default 30
Hot Plug hardware, module, selecting for install 25

�

IBM WebSphere Application Server. See 
WebSphere Application Server

Installation program
accepting license agreement 19
accessing for install 18
accessing for upgrade 61
completing the installation 54
customizing the installation 53
Domain Name Service (DNS), setting up 42
keyboard commands for GUI interface 32
license, server 49
mouse and video type, selecting 23
navigating install screens 18
NDS, setting up 44
NetWare file system, installing 34
NetWare partition and volume SYS, creating 28
networking products, installing 50
networking protocols, selecting 39
Novell Certificate Server, installing 51
platform support module and storage adapter, 

selecting 24
regional settings, specifying 22
server name, specifying 32
server settings, specifying 21
starting install 18
storage device and network board, selecting 26
task checklist 13
time zone, setting 44
type of installation, selecting 20

Internet Protocol. See IP
Internetwork Packet Exchange. See IPX
IP

installing pure 41
installing with IPX 41

installing with IPX Compatibility Mode 40
protocol options for Novell Client 90

IP address
Domain Name Service, for 42
setting for install 40

IPX
frame types 41
installing alone 41
installing with IP 41
protocol options for Novell Client 90

IPX Compatibility Mode
disabling 41
installing IP with 40
protocol option for Novell Client 90

�

Keyboard
commands for GUI install program 32
mapping, selecting 22

�

LAN driver, defined 27
LDAP Services for NDS, installing 110
License

agreement, accepting for install 19
server, installing 49

Login scripts
creating or modifying 100
sample 101

�

Migrating
from NetWare 3, using Novell Upgrade Wizard 

65
from NetWare 4 using Novell Upgrade Wizard 

70
process, planning 71

Mount volume, for install 38
Mouse type, selecting for install 23

�

Name of NetWare server, setting 32
Namespace

long, adding for Novell Client 91
verifying for Novell Upgrade Wizard 71
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NDPS (Novell Distributed Print Services), installing 
109

NDS
backing up and updating 16
choosing type of tree installation 45
existing tree, installing into 46
new tree, creating 47
setting up during install 44
version required by NetWare 5.1 16, 60
version, specifying for new install 21

NDS 7, functionality of 21
NDS 8

functionality of 21
preparing network for 16, 60, 73

NDS Manager, running 117
NDS tree

choosing installation type 45
creating for install 47
existing, installing into 46

NetWare 3, migrating from using Novell Upgrade 
Wizard 65

NetWare 4
migrating from using Novell Upgrade Wizard 70
server, preparing for install 16

NetWare Administrator
login scripts, creating or modifying using 100
running 116

NetWare Deployment Manager, preparing network 
for update 16, 60, 73

NetWare Enterprise Web Server, installing 104
NetWare file system

installing 34
volume, understanding 34
volumes, creating 35

NetWare FTP Server, installing 111
NetWare Loadable Module (NLM), loading during 

install 27
NetWare Management Portal, running 116
NetWare MultiMedia Server, installing 107
NetWare News Server, installing 105
NetWare partition

creating 28, 29
setting size of 29

NetWare Web Manager, installing 105
NetWare Web Search, installing 106
Network

installing new server from 18
upgrading from 61

Network administration tools, running
ConsoleOne 115
NDS Manager 117
NetWare Administrator 116
NetWare Management Portal 116
Novell Licensing Services 117

Network board
preparing for client workstation 92
selecting for install 26, 27

Networking products, installing
network administration tools 115
new products and services 104
overview 103
selecting during server install 50
traditional products and services 109

New installation, selecting 20
New products and services, installing

IBM WebSphere Application Server 108
NetWare Enterprise Web Server 104
NetWare MultiMedia Server 107
NetWare News Server 105
NetWare Web Manager 105
NetWare Web Search 106

NLM (NetWare Loadable Module), loading during 
install 27

NLS. See Novell Licensing Services
Novell Certificate Server, installing 51
Novell Client

Automatic Client Upgrade configuration file, 
modifying 98

copying install files from network 96
folder, creating for install 96
grant rights to folder for install 97
installing 89
installing from CD-ROM 94
installing from the network 96
login scripts, creating or modifying 100
long namespace, adding 91
platform-specific configuration files, updating 99
preparing to install software 90
software, locating 91
Windows 2000, upgrading client workstation for 

102
workstations, preparing 92

Novell Client Install Manager, running 99
Novell Directory Services. See NDS
Novell Distributed Print Services (NDPS), installing 

109
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Novell DNS/DHCP Services
installing 111

Novell Licensing Services
required for installation 16, 60
viewing license information 117

Novell Upgrade Wizard
destination server, preparing 67, 75
illustrated 63
migrating objects and volumes to destination 

server 68
planning migration from NetWare 4 71
post-migration tasks 69, 78
purpose of 63
running 67, 76
selecting files and objects to migrate 68
source server, preparing 66, 73
system and software requirements 65, 71
troubleshooting 79

NSS volume
creating 35
setting size of 29
understanding 34

Numbering scheme for servers, setting 21

�

Optional networking products. See also Networking 
products, installing

installing with new server 50
Organizational Certificate Authority (CA) object, 

creating 51

 

Partition, DOS
creating 17
verifying before upgrade 61

Partition, NetWare
creating 28, 29
setting size of 29

Platform support module (PSM), selecting for 
install 24

Post-migration tasks, for Novell Upgrade Wizard 
69, 78

Preparing network
for install 16
for upgrade 60, 73

Products, networking. See Networking products, 
installing

Protocol
installing IP and IPX together 41
installing IP only 41
installing IP with IPX Compatibility Mode 40
installing IPX only 41
selecting during install 39

PSM, selecting for install 24
Pure IP, installing 41

!

Regional settings, selecting for install 22
Requirements, system and software

for install 14
for Novell Upgrade Wizard 65, 71
for upgrade 58

Restoring NetWare 4 server to original 
configuration

multiserver tree 81
single server tree 87

Rights, granting for Novell Client installation 97
Router (gateway) address, specifying for install 40

"

Server
ID number, setting for new install 21
name, setting for install 32
protocols and requirements, for Novell Client 90
settings, specifyng for install 21
time zone, setting for install 44

SET parameters
changing 21
contained in STARTUP.NCF file 21

Setup utility, Novell Client 94
Software requirements

for install 15
for Novell Upgrade Wizard 65, 71
for upgrade 59

Source server
NetWare 3, preparing for Novell Upgrade 

Wizard 66
NetWare 4, preparing for Novell Upgrade 

Wizard 73
selecting files and objects to migrate 68

Startup directory, specifying 20
STARTUP.NCF file, SET parameters contained in 

21
Storage adapter, selecting for install 25
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Storage device, selecting for install 26, 27
Suballocation, editing for volume SYS 31
Subnet mask, setting 40
Summary of installation, illustrated 54
Support Pack, required for destination server 67
SYS volume. See Volume SYS
System requirements

for install 14
for Novell Upgrade Wizard 65, 71
for upgrade 58

#

Time zone, setting during install 44
Traditional products and services, installing

Catalog Services 113
LDAP Services for NDS 110
NetWare FTP Server 111
Novell Distributed Print Services 109
Novell DNS/DHCP Services 111
WAN Traffic Manager Services 114

Troubleshooting Novell Upgrade Wizard
restoring NetWare 4 server to original 

configuration 81, 87
unable to reconnect to destination server 80

$

Upgrade Wizard. See Novell Upgrade Wizard
Upgrading

preparing the server 61
system and software requirements 58
task checklist 57
using Novell Upgrade Wizard 63

%

Video type, selecting for install 23
Volume

creating during install 35
deleting during install 38
modifying during install 37
mounting for install 38
understanding 34

Volume SYS
block size, editing for install 31
creating 28, 30
editing properties of 31
removing existing during install 28
setting size of 30

&

WAN Traffic Manager Services, installing 114
WebSphere Application Server

disk space requirements for 14, 58
installing 108

Windows 2000, upgrading client workstation for 
102
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